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About DMTI Spatial™

DMTI Spatial Inc. is Canada’s leading spatial solutions provider. We enable users to understand their
customers, optimize resources, realize opportunities, maximize profitability and make more informed
decisions through accurate products and innovative thinking.

DMTI Spatial publishes precision built street map, rail and routing data (CanMap®), a detailed water layer,
and innovative geocoding and address management software (GeoPinpoint” ). In addition, DMTI Spatial
publishes a full range of positionally accurate geospatial data products including: enhanced points of
interest (EPOI), census data and boundaries, postal geography, topographic maps, and US mapping
data. As part of a complete business geographic solution, DMTI Spatial offers a wide range of GIS
services, consulting, and software training.

Established in 1994, DMTI Spatial is committed to setting the standard within the GIS industry for
precision built spatial data and geocoding software products.

At DMTI Spatial, we believe that our true strength comes from working closely with our customers and

providing innovative solutions to meet their strategic business objectives. As Canada’s premier spatial
solutions provider we pride ourselves with having worked with North America’s leading organizations to
support their mission critical applications.

DMTI Spatial works with large and small organizations representative of a wide variety of industries:

» Agriculture » Forestry * Mining

e Banking/Finance e Government * Real Estate

e Consulting e Health e Retalil

»  Education * High Technology * Telecommunications
» Emergency Services e Insurance » Transportation

» Engineering e Manufacturing e Utilities

»  Environmental * Media

We are a member of the ESRI Canada Business Partner Program, and winner of the 2001 ESRI
Worldwide New Business Partner of the Year Award and the 2005 ESRI Foundation Partner of the Year
Award. We are a strategic business partner of Mapinfo and winner of the Markham Board of Trade 2000
Award for Entrepreneurship and Innovation. Recipient of The Association of Canadian Map Libraries and
Archives (ACMLA) 2002 Certificate of Appreciation.

X
=

1)
%

ESRI Canada ®é— MapInfO

Business Partner
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Really Smart Spatial Solutions™

Page 2

Through the application of its products and services, DMTI Spatial has been involved with projects such
as: location-based services, logistics planning, emergency dispatch, facilities management, data
management, customer care, address management, land base development in support of network
planning, and marketing/demographic analysis applications.

DMTI Spatial can provide all of the components necessary for the acquisition, implementation, operation
and maintenance of a successful GIS system within companies of all sizes. Through its product and
service offering, DMTI Spatial can provide users with 5 key components:

1. Accurate, detailed and compatible data
2. Comprehensive maintenance program
3. GIS software

DMTI Spatial™ Product & Service Portfolio

DMTI Spatial's product & service offering includes:

CanMap® - Digital Map Data for Canada
. CanMap® Streetfiles

« CanMap® RouteLogistics

« CanMap® Rail

. CanMap® Major Roads and Highways
. CanMap® Parks & Recreation

« CanMap® Water

Satellite Imagery
e Satellite StreetView™

Municipal Amalgamations
« CanMap® Municipality Amalgamation File
(MAF)

Business & Recreational Points of Interest
» Enhanced Points Of Interest (EPOI)

GeoPinpoint ™ Suite

e Canada’s Geocoding Solution

* Modular Architecture

* Windows Standalone Desktop Version

* UNIX, Java Wrapper, ActiveX (DLL Version)

Topographic Data and Base Maps

e Canadian Atlas Map Bundle (CAMB)

» Populated Placenames

» National Topographic Data Base (NTDB)
e 30 & 90m Digital Elevation Models (DEM)
*  Clutter Data

Postal Geography & Data

e Six-Digit Postal Code File

» Enhanced Postal Code File

» Forward Sortation Areas (FSA) Boundary
File

www.dmtispatial.com

4. Consulting and services
5. Software training

1996 Census Boundaries & Demographic Data

* Enumeration Area (EA)

e Census Subdivision (CSD)

e Census Division (CD)

» Census Metropolitan Area/Census
Agglomeration (CMA/CA)

e Census Tract (CT)

» Federal Electoral Districts (FED)

2001 Census Boundaries

» Dissemination Area (DA)

e Census Subdivision (CSD)

e Census Division (CD)

» Census Metropolitan Area/Census
Agglomeration (CMA/CA)

e Census Tract (CT)

» Federal Electoral Districts (FED)

GIS Software

» Contour Modeling and Display

» Demographic Profiling and Lifestyle Targeting
e Geocoding and Mapping Software

* Routing and Logistics

Consulting and Services

» Application Development

» Database Marketing

» Data Conversion and Creation
» Database Scrubbing

e Geocoding Services

e GIS Consulting

» Technical Support

Proprietary and Confidential to DMTI Spatial

Not to be disclosed



[0 2005 DMTI Spatial Inc. Page 3

Technical Support, Error Reporting & Product Enhanc ement Services

DMTI Spatial is committed to building the best products possible for our customers. By using our data
every day in your mission critical application you are our best source for product refinement. Please let
us know if you have an enhancement request or found an error in any of our products so that we can
make the correction for the next release.

This is your opportunity to provide feedback directly to the DMTI Spatial Product Development Team.
Please be as specific as possible so that we can improve our products quickly and accurately. To submit
an error or request technical assistance please visit: http://www.dmtispatial.com/support/

If you have an idea for a new product, or an enhancement request for an existing product, please visit our
product manger’'s desk on the web at: http://www.dmtispatial.com/pm/
or e-mail: pm@dmtispatial.com

Contact Information

DMTI Spatial Inc.
625 Cochrane Drive, 3rd Floor
Markham, Ontario
L3R 9R9 Canada

Telephone: 905-948-2000
Toll Free: 1-877-477-DMTI (3684)
Fax: 905-948-9404

Web Site: www.dmtispatial.com

Error Reporting Service: fixme@dmtispatial.com
Product Enhancement Requests: pm@dmtispatial.com
Technical Support: support@dmtispatial.com

Trademarks and Notices

© 2005 DMTI Spatial Inc. CanMap is a registered trademark of DMTI Spatial Inc. DMTI Spatial, Really
Smart Spatial Solutions, Because Where Is What Matters and GeoPinpoint are trademarks of DMTI
Spatial Inc. All rights reserved. Other products and company hames mentioned herein may be
trademarks of their respective companies. Mention of third-party products is for informational purposes
only and constitutes neither a recommendation nor an endorsement.

DMTI Spatial is an Authorized User and Distributor of selected Statistics Canada Computer File(s) under
Licensing Agreement 6228. No confidential information about an individual, family, household,
organization or business has been obtained from Statistics Canada.

© Copyright, HER MAJESTY THE QUEEN IN RIGHT OF CANADA, as represented by the Minister of
Industry, Statistics Canada 2003.

Digital Topographic Data produced under License from Her Majesty the Queen in Right of Canada, with
permission of Natural Resources Canada and The Queen in Right of Manitoba.

www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
Not to be disclosed
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About CanMap® Routelogistics v2007.3

Layer Properties

Property Description

Coverage National

Currency August 15", 2007

Level of Accuracy Ranging from the National Topographic Data Base (NTDB) standard to
sub-meter accuracy

Projection unprojected Longitude-Latitude

Datum NAD83

Format ESRI and MaplInfo*

Layer Naming Conventions

CanMap RouteLogistics is organized into the following directory structure and uses the following directory
and file naming conventions:

Example: \CanMapRL\ON\Streets\ONhwy

Product Geographic Area General Content Geographic Area File Content
Directory Directory Directory Abbreviation Abbreviation
CanMapRL | ON Streets ON hwy

The geographic area directory area indicates the geographic coverage of the layer, for example ON =
Ontario.

The Geographic Area Name indicates the geographic extent of the file. DMTI Spatial's standard
geographic coverage areas include all Provinces and Territories as well the coverage areas found in the
CANItop file included with Bonus Canada Directory.

CanMap RouteLogistics contain the following general content directories:

Directory Name Description

Canada Canada Directory

POI Points of Interest Directory
Streets Streets Directory

Topo Topo Directory

! Custom formats available upon request. Refer to Appendix A: ESRI File Extensions and Appendix B: Maplnfo File Extensions for
more information regarding file extensions.
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About CanMap® RoutelLogistics v2007.3  (cont'd)

Layer Contents
CanMap RouteLogistics is comprised of the following layers:

Canada Directory

Layer Name Description Feature Type
CANacb Area Code Boundaries Polygon
CANcap Capital Cities Point
CANprv Provincial/Territorial Boundaries Polygon
CANrmn Regional Municipality Boundaries Polygon
CANtop Topographic Coverage Areas Polygon
CANtzs Time Zones (Standard Time) Polygon
CANtzd Time Zones (Daylight Savings Time) Polygon
CANwat National Water Polygon

The Canada Directory is included with the CanMap RouteLogistics product. For more information
regarding the Canada Directory refer to the Data Dictionary of CanMap RouteLogistics User Manual.

Points of Interest Directory

Layer Name Description Feature Type
AREAaer? Aerodromes Point
AREAcp| Car Pool Lots Paint
AREAedu Education Point
AREAgIf Golf Courses Point
AREAhcr Health Care Point
AREAppn Populated Placenames Point
AREAtol Toll Booths Point
AREAtrs Transportation Stops Point
AREAwgh Weigh Stations Point

The Points of Interest Directory is included with the CanMap RoutelLogistics product. For more
information regarding the Points of Interest Directory refer to the Data Dictionary of CanMap
RoutelLogistics User Manual.

Streets Directory

Layer Name Description Feature Type
AREAexc*® Expressways Casements Region
AREAfsa Forward Sortation Areas Region
AREAhpc Primary Highways Casements Region
AREAhrd Major Roads and Highways Line
AREAhsc Secondary Highways Casements Region
AREAhwy Highways Line
AREAInk Canada\US Roads Linkages Point
AREAIrc Local Roads Casements Region
AREAmaf Municipal Amalgamations File Region
AREAmMrc Major Roads Casements Region
AREAmMun Municipality Boundaries Region
AREArds_lut Roads Lookup Table None

2 Where AREA refers to a DMTI Spatial Standard Geographic Area
% Casements not available in Arcinfo Interchange Format (*.e00)
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(cont'd)

Layer Name Description Feature Type
AREAren Relative Elevation Nodes Point
AREArte Roads Line
AREArte lut Route Logistics Lookup Table None
AREAtlc Trails Casements Region
AREAtrn Turn Restrictions Table None
AREAtrr Transportation Route Restrictions Table None
AREAXit Highway EXxits Paint

For detailed information on other layers included in CanMap RoutelLogistics refer to the Data Dictionary
CanMap RouteLogistics User Manual. The following layers are specific to routing. For more information

regarding these layers refer to the Data Dictionary of the CanMap RoutelLogistics User Manual.

Layer Name Description

AREAaer Aerodromes

AREAwgh Weigh Stations

AREAfsa Forward Sortation Areas

AREAren Relative Elevation Nodes

AREArte Roads

AREArte_lut Route Logistics Lookup Table

AREAtrn Turn Restrictions Table

AREAtrr Transportation Route Restrictions Table
AREAXit Highway Exits

Topo Directory

Layer Name Description Feature Type
AREADf Building Footprints Region

AREAbp Building Points Point

AREAhs Hydrographic Structures Point, Line, Region
AREAhy Hydrography Point, Line, Region
AREAIr Industrial and Resource Point, Line, Region
AREAII Land Feature Labels Point

AREAIu Land Use Region

AREAOot Other Transportation Point, Line, Region
AREAph Physiography Point, Line, Region
AREApr! Parks and Recreation - Points Line

AREAprp Parks and Recreation - Lines Point

AREApIr Parks and Recreation - Regions Region

AREApt Pipelines and Transmission Point, Line, Region
AREA( Rail and Transit Lines Line

www.dmtispatial.com
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(cont'd)

Layer Name Description Feature Type
AREAve Vegetation Region
AREAwe Wetlands Region
AREAwWI Water Feature Labels Paint

All two-character Topo layer names are suffixed with a “p” (point), “I" (line/polyline), or “r” (region) to
indicate the object type contained within the file for Arcinfo, ArcView and ArcGIS formats only. For

example, the “hy” (Hydrography) theme is provided as “hyp” (containing points), “hyl” (containing lines),
and “hyr” (containing regions) files. All topographic layers may not be available for all geographical areas.

For more information regarding these layers refer to the Data Dictionary of CanMap RoutelLogistics User

Manual.
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Using CanMap® RouteLogistics V2007.3

Viewing DMTI Spatial Products

Packaged with DMTI Spatial products are several custom viewing files for MapInfo® Professional, ESRI®
ArcView® GIS and ESRI® ArcGIS®.

Software Extension Version Support

Maplnfo Professional *.wor Version 6.0 and higher
ESRI ArcView GIS *.apr Version 3.2 and higher
ESRI ArcGIS *.mxd Version 8.3 and higher

Located in the product directory, these viewing files have been provided to maximize the ease of use of
DMTI Spatial products by intelligently layering various data layers and displaying them based on
appropriate viewing scales.

Viewing CanMap RouteLogistics

There are currently two viewing files available for reference, mapping and analysis.

Filename Description

AREArte Offers a limited number of files for reference purposes only. Opens and zoom-
layers capital cities, populated placenames, roads, major roads and highways,
highways, municipality boundaries, and national water.

AREArtp Offers most of the files in the CanMap RoutelLogistics product for mapping and
analysis. Opens and zoom-layers almost all of the CanMap Routelogistics.
Includes labeling of roads, major roads & highways, highways, populated
placenames, municipality boundaries, regional municipality boundaries, provincial
boundaries.

CanMap RouteLogistics workspaces or project files are found in the product directory:

example: \Cl@L\ON\ONr{l

Product Directory eographic Area Geographic Area Workspace/
Directory Abbreviation Project File Type

CanMapRL | ON | ON | rte

Suggested Layering for CanMap Streetfiles

If you wish to view the CanMap product without the aid of the provided viewing files or the format
purchased does not come with them, DMTI Spatial” recommends using the following layering system to
view your CanMap product:
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Layering in MapInfo

Layer Description

cap Capital Cities

Xit Highway EXxits

I Land Feature Labels

wi Water Feature Labels

aer Aerodromes

cpl Car Pool Lots

edu Education

glf Golf Courses

hcr Health Care

ppn Populated Placenames

tol Toll Booths

trs Transportation Stops

wgh Weigh Stations

prp Parks and Recreation - Points
prl Parks and Recreation - Lines
pt Pipelines and Transmission
bp Building Points

bf Building Footprints

rl Railway and Transit Lines
exc Expressways Casements

hpc Primary Highways Casements
hsc Secondary Highways Casements
mrc Major Roads Casements

Irc Local Roads Casements

tlc Trails Casements

rte Roads

hrd Major Roads and Highways
hwy Highways

hs Hydrographic Structures

ot Other Transportation

ir Industrial and Resource

ph Physiography

we Wetlands

hy Hydrography

prr Parks and Recreation - Regions
ve Vegetation

lu Land Use

wat National Water

fsa Forward Sortation Areas

www.dmtispatial.com
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Using CanMap® RouteLogistics V2007.3 (cont'd)

Layer Description
top Topographic Coverage Areas
rmn Regional Municipality Boundaries
mun Municipality Boundaries
prv Provincial Boundaries

Layering in ArcView, ArcGIS

Layer Description

cap Capital Cities

Xit Highway EXxits

lp Land Feature Labels

wlip \Water Feature Labels

aer Aerodromes

cpl Car Pool Lots

edu Education

glf Golf Courses

hcr Health Care

ppn Populated Placenames

tol Toll Booths

trs Transportation Stops

wgh Weigh Stations

prp Parks and Recreation - Points
ptp Pipelines and Transmission - Points
otp Other Transportation - Points
bpp Building Points

hsp Hydrographic Structures - Points
irp Industrial and Resource - Points
php Physiography - Points

hyp Hydrography - Points

prl Parks and Recreation - Lines

ptl Pipelines and Transmission - Lines
otl Other Transportation - Lines

bfr Building Footprints

rll Rail - Lines

exc Expressways Casements

hpc Primary Highways Casements
hsc Secondary Highways Casements
mrc Major Roads Casements
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial

Not to be disclosed



[0 2005 DMTI Spatial Inc.

Using CanMap® Routelogistics V2007.3

(cont'd)

Layer Description

Irc Local Roads Casements

tic Trails Casements

rte Roads

hrd Major Roads and Highways

hwy Highways

hsl Hydrographic Structures - Lines

irl Industrial and Resource - Lines
phl Physiography - Lines

hyl Hydrography - Lines

ptr Pipelines and Transmission - Regions
otr Other Transportation - Regions
hsr Hydrographic Structures - Regions
irr Industrial and Resource - Regions
phr Physiography - Regions

wer Wetlands

hyr Hydrography - Regions

prr Parks and Recreation - Regions
ver \Vegetation

lur Land Use

wat National Water

fsa Forward Sortation Areas

top Topographic Coverage Areas

rmn Regional Municipality Boundaries
mun Municipality Boundaries

prv Provincial Boundaries

Other CanMap Layers

Layer Description

ach Area Code Boundaries

Ink Canada\USA Roads Linkages

ren Relative Elevation Nodes

rte lut RoutelLogistics Lookup Table

trn Turn Restrictions Table (dbf)

trr Transportation Route Restrictions
rds_lut Roads Lookup Table

tzs Time Zones (Standard Time)

tzv Time Zones (Daylight Savings Time)

www.dmtispatial.com
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Data Dictionary

Area Code Boundaries (acb)

Layer Location
\Canada\CANach
Layer Structure

Field Name Field Type Field Size Description
AREA CODE Character 8 Area Code
AREA PROV Character 8 Provincial/Territorial Abbreviation. Records

may contain multiple abbreviations where
area codes are shared between provinces or
territories.

Layer Content

Based on CanMap Municipality Boundaries, area code boundaries represent Canadian telephone area
codes. In the North American telephone system, an area code is a three-digit code delineating a “toll”
and is distributed according to the North American Number Plan (NANP). An area code is also referred to
as a Number Plan Area or NPA.*

Province Area Code Province Area Code
AB 403 ON 613

AB 780 ON 705

BC 250 ON 807

BC 604/778 ON 905/289
MB 204 QC 418

NB 506 QC 450

NL 709 QC 514
NS/PE 902 QC 819

ON 416/647 SK 306

ON 519 YT/NT/NU 867

“ Source: North American Numbering Plan Administration, September 2003
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Data Dictionary (cont’d)

Capital Cities (cap)

Layer Location
\Canada\CANcap

Layer Structure

Field Name Field Type Field Size Description
NAME Character 68 Name of City
PROV Character 2 Provincial/Territorial Abbreviation

Layer Content

Derived from CanMap Populated Placenames, capital cities represent all provincial and territorial capital
cities and the national capital city.
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Data Dictionary (cont'd)

Provincial Boundaries (prv)

Layer Location
\Canada\CANprv

Layer Structure

Field Name Field Type [Field Size Description
NAME Character 25 Provincial/Territorial Name
PROV Character 2 Provincial/Territorial Abbreviation

Layer Content

The Provinces layer is comprised of the 10 Provinces and 3 Territories that define Canada for political
administrative purposes. DMTI Spatial Provinces and Territories correspond to Statistics Canada 2001
Provinces and Territories (PR)
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Data Dictionary (cont’d)

Regional Municipality Boundaries (rmn)

~J

kg

R SO SIMCOE COUNTY,

NQRTHUMBERLAND COLN

Layer Location
\Canada\CANrmn

Layer Structure

Field Name Field Type [Field Size Description
NAME Character 46 Census Division Name
PROV Character 2 Provincial/Territorial Abbreviation

Layer Content
The Regional Municipalities layer is comprised of intermediate political administrative areas between the

Province/Territories and Municipalities. DMTI Spatial Regional Municipalities correspond to Statistics
Canada 2001 Census Divisions (CD).

Field Content

Type |Description

CTY |County
CuU Communauté urbaine
DIS |District

DIV |Census Division

DM  |District Municipality

MRC |Municipalité régionale de comté
RD Regional District

REG |Region

RM  |Regional Municipality

TER |Territory

UC  |United Counties
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Data Dictionary (cont'd)

Topographic Coverage Areas (top)

W

AmigaBeach

Meiard
g o ribwen

Goncaygen

»
elnck

- arfpbetion
Millroak EE
Brighitn

vAolbury

Markdale Wi 327
Duam  Dundalk
Shelbuaye;
MoungForest
Harrston
balmerstonAtaur
tgwe| DFEHON

Greater Toronto Area

Layer Location
\Canada\CANtop

Layer Structure

Field Name Field Type Field Size Description

NAME Character 68 Topographic Coverage Area Name®

NAME_ABBR Character 5 Topographic Coverage Area
Abbreviation

PROV Character 2 Provincial/Territorial Abbreviation

Layer Content

Topographic coverage areas represent areas across Canada where DMTI provides topographic data.
Topographic data includes general land-use classifications, building footprints, transportation and utility
features, hydrographical features, and physiographical features. Currently there are over 700 topographic
coverage areas across the country.

® Refer to Appendix H: Canadian Urban Areas and Abbreviations for more information.
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Data Dictionary (cont’d)

Time Zones — Standard Time (tzs) / Daylight Savings  Time (tzd)

Layer Location
\Canada\CANtzs
\Canada\CANtzd

Layer Structure

Field Name Field Type Field Size Description

ZONE_NAME Character 30 Time Zone Name

ZONE_ABBR Character 3 Time Zone Abbreviation

DEVFROMUTC | Character 5 The difference in hours from
Coordinated Universal Time (UTC) or
Greenwich Mean Time (GMT)

Layer Content

Canada has six time zones, which are regulated by provincial and territorial governments. In each time
zone Standard or Daylight Saving time might be specified. For example, in Ontario, Eastern Standard
Time is denoted as Coordinated Universal Time (“UTC”) less 6 hours or Eastern Daylight Time as UTC —
4h. In most regions in Canada, Daylight Savings Time begins on the first Sunday of April and ends on
the last Sunday of October.

In some parts of Canada, observed time practice differs from official legislated time. The time zones in
DMTI Spatial's time zone data are derived from provincial and territorial legislation and regulations that
were in effect as of April 1, 2001 (Legislated Time Zones).*®

® Refer to Appendix I: Exceptions to Official Time in Canada for more information.
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Data Dictionary (cont’d)

National Water (wat)

Layer Location
\Canada\CANwat

Layer Structure

Field Name Field Type Field Size Description

NAME Character 40 Lake/River Name

Layer Content

The national water layer contains generalized major water bodies derived from a variety of sources at
scales ranging from 1:50 000 to 1:30 000 000.”

" For more information refer to Appendix J: Unshorelined and Shorelined Boundaries
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Expressway Casements (exc)

Layer Location
\Streets\AREAexc

Layer Structure

Field Name Type Size | Description
STREET® Character |64 Street Title
RDS_ID Decimal 9,0 Uniqueld of related Roads (rds) segment

& For more information refer to Appendix C: Street Types and Street Directions
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Forward Sortation Areas (fsa)

Layer Location

\Streets\AREAfsa

Layer Structure

Field Name Type Size | Description

FSA Character | 3 Forward Sortation Area
PROV Character | 2 Province Abbreviation®
PROV_CODE Character | 2 Province Code®

Layer Content

The first three characters of a postal code represent the Forward Sortation Area (FSA) indicating a
geographic area in an urban or rural area. The first character of the Forward Sortation Area identifies one
of the 18 major geographic areas, provinces or districts.

The second numeric character (numerals 0-9) of the Forward Sortation Area Boundary identifies either an
urban postal code or a rural postal code. Rural postal code are represented by the numeral 0 (zero) for
example, AOA) and are serviced by rural route drivers and/or postal outlets. An urban postal code is
represented by the numerals 1 to 9 for example, E2J and are generally serviced by letter carrier or
community mailboxes.

The third character of the Forward Sortation Area segment (E2J) in conjunction with the first two
characters, describes an area of a city or town or other geographic area.

® Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002
1% Source: Statistics Canada, Standard Geographical Classification (SGC), 2001
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First Letter
of FSA

Geographic Area

Newfoundland & Labrador

Nova Scotia

Prince Edward Island

New Brunswick

Quebec (east)

Québec (metropolitan Montréal)

Quebec (west)

Ontario (east)

Ontario (central)

Ontario (metropolitan Toronto)

Ontario (southwest)

Ontario (northern)

Manitoba

Saskatchewan

Alberta

British Columbia

Northwest Territories/Nunavut

<X <|[HA|w|D|D|IZ|IZ TR ITOMO|®| >

Yukon Territory
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Data Dictionary (cont’d)

Primary Highway Casements (hpc)

Layer Location
\Streets\AREAhpc

Layer Structure

Field Name Type Size Description
STREET Character 64 Street Title
RDS _ID Decimal 9,0 UniquelD of related Roads (rds)
segment
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Data Dictionary (cont’d)

Major Roads and Highways (hrd)

Layer Location
\Streets\AREAhrd

Layer Structure

Field Name Field Type Field Size Description
STREET Character 69 Street Name
CARTO Decimal 3,0 Cartographic Road Classification
LEFT_MUN Character 70 Municipality
RIGHT_MUN Character 70 Municipality
LEFT_MAF Character 70 Municipal Amalgamation
RIGHT_MAF Character 70 Municipal Amalgamation
LEFT_FSA Character 3 Forward Sortation Area
RIGHT_FSA Character 3 Forward Sortation Area
LEFT_PRV Character 2 Provincial/Territorial Abbreviation
RIGHT_PRV Character 2 Provincial/Territorial Abbreviation
UNIQUEID Decimal 9,0 Unique ldentifier of Street segment

Field Content

Please note that as of CanMap v8.2 the Municipality (_ MUN) fields are attributed with 2001 Census
based Municipality names. 1996 Census based Municipality names can be obtained by linking the hrd
layer to the rds_lut layer via the UNIQUEID and RDS_ID fields.
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Secondary Highway Casements (hsc)

Layer Location
\Streets\ AREAhsc

Layer Structure

Field Name Type Size | Description
STREET" Character |64 Street Title
RDS_ID Decimal 9,0 Uniqueld of related Roads (rds) segment

" For more information refer to Appendix C: Street Types and Street Directions
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Data Dictionary (cont’d)

Highways (hwy)

Layer Location
\Streets\AREAhwy

Layer Structure

Field Name Type Size | Description

STREET" Character |69 Street Name

CARTO® Decimal 3,0 Cartographic Road Classification
LEFT_MUN Character |70 Municipality

RIGHT_MUN Character |70 Municipality

LEFT_MAF Character | 70 Municipal Amalgamation

RIGHT MAF Character | 70 Municipal Amalgamation

LEFT FSA Character |3 Forward Sortation Area
RIGHT_FSA Character |3 Forward Sortation Area
LEFT_PRV Character |2 Provincial/Territorial Abbreviation
RIGHT_PRV Character |2 Provincial/Territorial Abbreviation
UNIQUEID Decimal 9,0 Unique Identifier of Street segment

Field Content

Please note that as of CanMap v8.2 the Municipality (_ MUN) fields are attributed with 2001 Census
based Municipality names. 1996 Census based Municipality names can be obtained by linking the hwy
layer to the rds_lut layer via the UNIQUEID and RDS_ID fields.

2 For more information refer to Appendix C: Street Types and Street Directions
'3 For more information refer to Appendix D: Cartographic Road and Rail Classifications
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Canada\USA Roads Linkages (Ink)

Layer Location

\Streets\AREAInk

Layer Structure

Field Name Type Size Description

RDS ID Decimal 9,0 Uniqueld of related Roads (rds) segment
CAN_STREET | Character | 69 Canadian Street at Roads Linkage
PROV Character | 2 Provincial/Territorial Abbreviation

USA STREET | Character | 69 American Street at Roads Linkage
STATE Character | 2 State Abbreviation

PORT _ENTRY | Character | 100 Port of Entry Name (where applicable)
LONGITUDE Decimal 11,6 Longitude of Roads Linkage

LATITUDE Decimal 11,6 Latitude of Roads Linkage
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Local Road Casements (Irc)

Layer Location

\Streets\AREAIrc

Layer Structure

Field Name Type Size | Description
STREET" Character |64 Street Title
RDS_ID Decimal 9,0 Uniqueld of related Roads (rds) segment

* For more information refer to Appendix C: Street Types and Street Directions
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Data Dictionary (cont’d)

Municipal Amalgamation File (maf)
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Layer Location
\MAR\AREAmMaf

Layer Structure

Field Name Field Type Field Size Description

NAME Character 70 Municipality name

PROV Character 2 Provincial/Territorial Abbreviation.

TYPE Character 3 Municipality type

EFF_DATE Character 8 Date the municipal amalgamation change
comes into effect. Date appears in
YYYYMMDD format. Null records indicate
that amalgamations have not occurred.

Layer Content

The Municipal Amalgamation File (MAF) is a supplementary municipality boundary with CanMap[
Streetfiles and CanMap[] RoutelLogistics and reflects recent changes to any amalgamated municipal
boundaries, their subsequent changes to name, municipality type and date of amalgamation. An
amalgamation is defined as a consolidation of two or more entire municipalities.

Derived from Statistics Canada 2001Census the Municipal Amalgamation file contains:

* Municipal amalgamations that have occurred since the 2001 Census

* Municipal amalgamations based on provincial/territorial sources

* Census Subdivision Name and Type revisions from the 2001 Census
Municipality type refers to the census subdivision (CSD) type definition given to a municipality by
Statistics Canada. “CSD* is the general term for municipalities (as determined by provincial legislation) or
areas treated as municipal equivalents for statistical purposes (for example, Indian reserves, Indian
settlements and unorganized territories).
Census subdivisions (CSDs) are classified into 46 types according to official designations adopted by

provincial or federal authorities.” The following table provides a list of CSD types and their
abbreviations:*

% Source: Statistics Canada, Standard Geographical Classification (SGC), 2001
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Type Description Type Description

C City RDA Regional District

CC Chartered Community Electoral Area

CM County (Municipality) RG Region

COM Community RGM Regional Municipality

CT Canton (Municipalité RM Rural Municipality
de) RV Resort Village

Cu Cantons unis S-E Indian Settlement /
(Municipalité de) Etablissement indien

DM District Municipality SA Special Area

HAM Hamlet SCM Subdivision of County

ID Improvement District Municipality

IGD Indian Government SET Settlement
District SM Specialized

IM Island Municipality Municipality

LGD Local Government SUN Subdivision of
District Unorganized

LOT Township and Royalty SV Summer Village

M Municipalité T Town

MD Municipal District Tl Terre inuite

NH Northern Hamlet TL Teslin Land

NL Nisga’'a Land TP Township

NV Northern Village TR Terres réservées

NVL Nisga'a Village UNO Unorganized / Non-

P Paroisse (Municipalité oraganisé
de) \Y Ville

PAR Parish VC Village cri

R Indian Reserve / VK Village naskapi
Réserve indienne VL Village

RC Rural Community VN Village nordique
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Major Roads Casements (mrc)

Layer Location

\Streets\AREAmrc

Layer Structure

Field Name Type Size | Description
STREET™ Character | 64 Street Title
RDS_ID Decimal |9,0 Uniqueld of related Roads (rds) segment

'® For more information refer to Appendix C: Street Types and Street Directions
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Data Dictionary (cont’d)

Municipality Boundaries (mun)

Layer Location
\Streets\AREAmMun

Layer Structure

Field Name Type |Size |Description

NAME C 70 Municipality Name

TYPE C 3 Municipality Type

POP2001 D 8,0 2001 Census Population Count

DWELL2001 D 7,0 2001 Census Dwelling Count

AREA SQKM D 12,4 | Area (square kilometers) from Statistics Canada Land Base
POP_SQKM D 13,4 | Population Density (per square kilometer)

PROV cC 2 Provincial/Territorial Abbreviation

Layer Content

The Municipalities layer is comprised of political administrative entities such as cities, towns, or villages.
The DMTI Spatial Municipalities layer corresponds to the Statistics Canada 2001 Census Subdivisions

(CSD).

Field Content

Type

The Municipality Type is used

to help distinguish Municipalities having the same name from one another.

The Municipality Types correspond to the Statistics Canada 2001 Census Subdivision (CSD) Types.
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Type |Description Type |Description

C City — Cité RDA |[Regional District Electoral Area
CC |Chartered Community RG |Region

CM  |County (Municipality) RGM |Regional Municipality

COM |Community RM  [Rural Municipality

CT |Canton (Municipalité de) RV |Resort Village

CU |Cantons unis (Municipalité de) S-E |Indian Settlement - Etablissement indien
DM |District Municipality SA  |Special Area

HAM [Hamlet SCM |Subdivision of County Municipality
ID Improvement District SET |Settlement

IGD |Indian Government District SM  |Specialized Municipality

IM Island Municipality SUN |Subdivision of Unorganized
LGD |Local Government District SV |Summer Village

LOT [Township and Royalty T Town

M Municipalité TI Terre inuite

MD  |Municipal District TL |Teslin Land

NH  [Northern Hamlet TP  |[Township

NL |Nisga'a Land TR |Terres réservées

NV  |Northern Village UNO |Unorganized - Non organisé
NVL [Nisga'a Village \ Ville

P Paroisse (Municipalité de) VC |Village cri

PAR |Parish VK |Village naskapi

R Indian Reserve - Réserve indienne VL |Village

RC |Rural Community VN |Village nordique
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Data Dictionary (cont’d)

Roads Look Up Table (rds_lut)

Layer Location
\Streets\AREArds_lut

Layer Structure

Field Name Type Size | Description

RDS_ID Decimal 9,0 Uniqueld of related Roads (rds) segment
ALIAS_NAME Character | 69 Alternate Street Name

FORMERNAME" | Character |69 Former Provincial Hwy Name

HWY_NUM Character | 20 Highway Number(s) (e.g. 404)
HWY_NUMNAM Character | 69 Highway Numeric Name (e.g. Highway 404)
HWY_NAME Character | 69 Highway Name Non-Numeric (e.g. Don Valley Pky)
RD_NUM Character | 20 Road Number (e.g. 4)

RD_NUMNAM Character | 69 Road Numeric Name (e.g. Regional Rd 4)
RD_NAME Character | 69 Road Name Non-Numeric (e.g. Taunton Rd W)
ALASKAHWY Decimal 1,0 | Alaskan Highway flag

CARIBOOHWY Decimal 1,0 | Cariboo Highway flag

CRWSNSTHWY Decimal 1,0 | Crowsnest Highway flag

DEMPSTRHWY Decimal 1,0 Dempster Highway flag

JOHNHRTHWY Decimal 1,0 | John Hart Highway flag

KLONDKEHWY Decimal 1,0 Klondike Highway flag

MCKNZIEHWY Decimal 1,0 Mackenzie Highway flag

TRNSCDAHWY Decimal 1,0 | TransCanada Highway Flag

YELOWHDHWY Decimal 1,0 | Yellow Head Highway Flag

TOLL_RD Decimal 1,0 | Toll Road Flag

BRIDGE Decimal 1,0 Bridge Flag

TUNNEL Decimal 1,0 | Tunnel Flag

BRUNNELNAM Character | 69 Bridge/Tunnel Name
TRAILNAME Character | 100 | Trail Name

TRAILTYPE Character | 50 Trail Type

TRAILCLASS Character | 20 Trail Class

TRAILCODE Decimal 4,0 | Trail Code

L_MUN_96 Character | 68 Municipality (1996 Census based)
R_MUN_96 Character | 68 Municipality (1996 Census based)

7 Applicable only in Ontario
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Trail Classes, Types and Codes

TrailCode [TrailType TrailClass

1000 OTHER PARK PARK

1001 NATIONAL PARK PARK

1002 PROVINCIAL PARK PARK

1003 MUNICIPAL PARK PARK

1004 CONSERVATION AREA PARK

1005 NATIONAL HISTORIC SITE PARK

1006 WILDLIFE/NATURE SANCTUARY PARK

1007 EXHIBITION GROUNDS PARK

2000 OTHER RECREATIONAL RECREATIONAL

2001 HIKING/WALKING RECREATIONAL

2002 BIKING RECREATIONAL

2003 RIDING RECREATIONAL

2004 SNOWMOBILE RECREATIONAL

2005 SKIING RECREATIONAL

2006 GOLF COURSE RECREATIONAL

2007 PORTAGE RECREATIONAL

3000 OTHER PRIVATE PRIVATE

3001 TOWNHOUSE/CONDOMINIUM PRIVATE

3002 SHOPPING MALL PRIVATE

3003 TRAILER PARK PRIVATE

3004 LOGGING ROAD PRIVATE

3005 CEMETERY PRIVATE

3006 ALLEY WAY PRIVATE

3007 AIRPORT/HELIPORT PRIVATE

3008 ABANDONED RAILWAY PRIVATE

3009 INDUSTRIAL PRIVATE

3010 FOREST SERVICE ROAD PRIVATE

3011 REST AREA PRIVATE

3012 SERVICE STATION PRIVATE

3013 ABANDONED ROAD PRIVATE

3014 COUNTRY CLUB PRIVATE

3015 HOTEL/MOTEL PRIVATE

3016 RETAIL/OFFICE PRIVATE

4000 OTHER EMERGENCY SERVICES EMERGENCY SERVICES
4001 HOSPITAL EMERGENCY SERVICES
4002 FIRE ACCESS EMERGENCY SERVICES
4003 EMERGENCY SERVICES ROAD EMERGENCY SERVICES
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Trail Classes, Types and Codes (con't)

TrailCode [TrailType TrailClass

5000 OTHER EDUCATIONAL EDUCATIONAL
5001 PRIVATE ELEMENTARY SCHOOL EDUCATIONAL
5002 PUBLIC ELEMENTARY SCHOOL EDUCATIONAL
5003 PRIVATE HIGHSCHOOL EDUCATIONAL
5004 PUBLIC HIGHSCHOOL EDUCATIONAL
5005 UNIVERSITY EDUCATIONAL
5006 COLLEGE EDUCATIONAL
5007 MILITARY SCHOOL EDUCATIONAL
5008 SEPARATE ELEMENTARY SCHOOL EDUCATIONAL
5009 SEPARATE HIGHSCHOOL EDUCATIONAL
6000 OTHER GOVERNMENT GOVERNMENT
6001 EXPERIMENTAL FARM GOVERNMENT
6002 DEPARTMENT OF NATIONAL DEFENCE GOVERNMENT
6003 CORRECTIONAL FACILITY GOVERNMENT
6004 WEIGH STATION GOVERNMENT
6005 PEDESTRIAN WALK WAY GOVERNMENT
6006 POLICE TRAINING FACILITY GOVERNMENT
6007 SEWAGE OR WATER TREATMENT FACILITY |GOVERNMENT
6008 NO PUBLIC ACCESS/BUS ROUTE GOVERNMENT
7000 LIMITED USE ROAD: OTHER LIMITED USE ROAD
7001 LIMITED USE ROAD: WINTER LIMITED USE ROAD
7002 LIMITED USE ROAD: DRY WEATHER LIMITED USE ROAD
7003 LIMITED USE ROAD: CART TRACK LIMITED USE ROAD
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Trail Casements (tlc)

Layer Location

\Streets\AREAtlc

Layer Structure

Field Name Type Size | Description
STREET® Character | 64 Street Title
RDS_ID Decimal 9,0 | Uniqueld of related Roads (rds) segment

'8 For more information refer to Appendix C: Street Types and Street Directions
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Data Dictionary (cont’d)

Aerodromes (aer)

+
+ +
+
+
+
Layer Location
\PONAREAaer
Layer Structure
Field Name Type Size | Description
NAME Character | 150 Aerodrome name
CITY Character | 68 City (or closest Municipality)
PROV Character | 2 Province Abbreviation
ICAO_CODE Character | 4 4 Character Aerodrome Location Indicator
IATA_CODE Character | 3 3 Character Aerodrome Location Indicator
AER_TYPE Character | 10 Description of type of Aerodrome
STATUS Character | 10 Operational status of Aerodrome
NAME_ALIAS Character | 125 Aerodrome name alias
PREC_CODE Character | 2 Code indicating the positional accuracy or precision of the
geocoded feature
ATTRIBCODE Character | 2 Code indicating the accuracy of the attribute data
POIL_ID Character | 15 Unique ID

Layer Content

Name
When the geographic location is not reflected in the Aerodrome name, the name of the community is
placed before the Aerodrome name separated by a forward slash.

Name_Alias
Provides a commonly used name.

Community
Aerodrome Name Name Other Name Name Alias
Lester B Pearson
Toronto/Lester B. Pearson Intl Toronto Lester B. Pearson Intl International Airport
Montréal/St-Hubert Montréal St-Hubert Aeroport de Saint-Hubert
Calgary/Springbank Calgary Springbank Calgary Springbank Airport
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Data Dictionary (cont’d)

Car Pool Lots (cpl)

ot
= = e
=] =
= Ax
= =
= = = -
=] =
)
]
HE (=1
Layer Location
\PONAREACcpI
Layer Structure
Field Name Type Size | Description
NAME Character |150 Car Pool Lot name
LOCATION Character |100 Car Pool Lot Location
CITY Character |68 City (or closest Municipality)
PROV Character |2 Province (Abbreviation)
EXIT_NUM Character |5 Highway Exit Number at Car Pool Lot Location
DIRECTION Character |2 Direction of Highway at Car Pool Lot Location
Code indicating the positional accuracy or precision of the
PREC_CODE®" |Character |2 geocoded feature
ATTRIBCODE Character |2 Code to indicate the accuracy of the attribute data
POI _ID Character |15 Unique ID

19 Refer to the Appendix G: Geographical Placement of Data for more information.
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Data Dictionary (cont’d)

Education (edu)

Layer Location
\PONAREAedu

Layer Structure

Field Name Type Size

Description

NAME Character | 150

Educational facility name

PREC _CODE® |Character |2

Code indicating the positional accuracy or precision of the
geocoded feature

ATTRIBCODE Character |2

Code to indicate the accuracy of the attribute data

POI _ID Character |15

Unique ID

Layer Content

Includes Elementary, High Schools, Colleges, Cégeps and Universities.

% Refer to the Appendix G: Geographical Placement of Data for more information.
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Data Dictionary (cont’d)

Golf Courses (glf)

Layer Location
\PONAREAgIf

Layer Structure

Field Name Type Size | Description

NAME Character |150 | Golf Course name

Code indicating the positional accuracy or precision of the
PREC _CODE* |Character |2 geocoded feature

ATTRIBCODE Character |2 Code to indicate the accuracy of the attribute data

POI_ID Character |15 Unique ID

Layer Content

Includes both Private and Public golf courses as well as their locations, phone numbers and number of
holes.

! Refer to the Appendix G: Geographical Placement of Data for more information.
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Data Dictionary (cont’d)

Health Care (hcr)

+
+
+
+
+ +
+
]
Layer Location
\PONAREAhcr
Layer Structure
Field Name Type Size | Description
NAME Character |150 | Health Care facility name

Code indicating the positional accuracy or precision of the
PREC CODE?* Character |2 geocoded feature

ATTRIBCODE Character |2 Code to indicate the accuracy of the attribute data
POI_ID Character |15 Unique ID (link to main POI database)

Layer Content

Includes Hospitals, Long-Term Care Centers, Nursing Stations, Outpatient Clinics and Community Health
Centers.

2 Refer to the Appendix G: Geographical Placement of Data for more information.
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Popu!ated Placepe}mes (ppn)

Layer Location

\PONAREAppN

Layer Structure

Field Name Field Type Field Size Description

NAME Character 68 Placename

PROV Character 2 Provincial/Territorial Abbreviation

LONGITUDE Decimal 11,6 Longitude of Populated Placename

LATITUDE Decimal 11,6 Latitude of Populated Placename

PPN _CODE Decimal 3,0 Populated Placename Code

PREC_CODE Decimal 2,0 Code indicating the positional accuracy or
precision of the geocoded feature

MJR_CITY Decimal 1,0 Identifies cities with populations > 100,000

CAPITAL Decimal 1,0 Identifies provincial capital cities and the
national capital

PRCDCSD Character 8 2001 Census Subdivision (CSD) code in
which the placename is located

CSD_NAME Character 68 2001 Census Subdivision (CSD) name in
which the placename is located

CSD_POPO01 Decimal 8,0 Census Subdivision (CSD) population (2001)
in which the placename is located

Layer Content

Based on both the Canadian Geographic Names Database® and Statistics Canada, the CanMap
Populated Placenames file provides a rich and extensive layer of cities, towns, villages and
communities across Canada. CanMap Populated Placenames have been enhanced by verifying

and aligning points with CanMap® Streetfiles.

PPN_Code Type of Populated Placename

101 Capital City

100 Major City

Minor City

Town

Urban Community

Urban Fringe

Urban Area

OO |WIN|F

Rural Community

% gource: Natural Resources Canada, Canadian Geographical Names Database (CGNDB), 1999
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Data Dictionary (cont’d)

Toll Booths (tol)

ol
0 fl
)
AR
fl
Layer Location
\PONAREAtol
Layer Structure
Field Name Type Size | Description
NAME Character | 150 | Toll Booth nhame
LOCATION Character | 100 | Toll Booth location
CITY Character |68 | City (or closest Municipality)
PROV Character | 2 Province (Abbreviation)
DIRECTION Character | 2 Direction of Highway at Car Pool Lot Location
Code indicating the positional accuracy or precision of the
PREC _CODE* |Character |2 geocoded feature
ATTRIBCODE Character |2 Code to indicate the accuracy of the attribute data
POI_ID Character |15 | Unique ID

2 Refer to the Appendix G: Geographical Placement of Data for more information.
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Transportation Stops (trs)

Layer Location
\PONAREAtrs

Layer Structure

Field Name Type Size Description

NAME Char 150 Transportation Stop hame

CITY Char 68 City or municipality

PROV Char 2 Provincial/Territorial Abbreviation

TRS_TYPE Char 25 Transportation Stop classification (if
available)

OWNER Char 68 Transportation Stop owner/operator

ROUTE Char 100 Transportation Stop Route

TRS NUM Char 8 Transportation Stop humber (if available)

CODE Decimal 4,0 Classification Code

PREC CODE Char 2 Precision Code

ATTRIB CODE Char 2 Attribute Code

POI ID Char 15 Transit Stop unique identifier (Unique 1D)

% Bus and Rail Transit stops have been merged with the Railway Stops to create a Transportation
Stops layer. Some fields were added and others changed name or type to accommodate the
transit data. See table above for descriptions of each field.

Layer Content

CODE FEATURE

150 BUS STOP

151 BUILDING: RAPID TRANSIT STATION

152 BUILDING: LIGHT RAIL TRANSIT STATION
154 BUILDING: COMMUTER RAIL STATION
155 BUILDING: RAILWAY STATION
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Data Dictionary (cont’d)

Weigh Stations (wgh)

[ ]
[
[ ]
[ ]
| ]
[
Layer Location
\PONAREAwgh
Layer Structure
Field Name Type Size Description
NAME Character 150 Name of Weigh Station
LOCATION Character 100 Location of Weigh Station
DELIV_MODE Character 25 P.O. Box# or Unit#
CITY Character 68 City (or closest Municipality)
PROV Character 2 Province
POST_CODE Character 7 Postal Code
PHONE Character 15 Telephone#
FAX Character 15 Fax#
WGH_TYPE Character 10 Permanent or Portable Scale
DIRECTION Character 2 Indicates the direction of road scale is on
HOURS Character 20 Hours of operation
YEAR_ROUND Decimal 1,0 Year Round operation
RESTROOM Decimal 1,0 Restrooms available
AVION401 Decimal 1,0 Avion 401 automated clearance system
PREC CODE Character 5 Code indicating the positional accuracy or precision of
- the geocoded feature

ATTRIBCODE Character 2 Code indicating the accuracy of the attribute data
POI_ID Character 15 Unique ID
www.dmtispatial.com Proprietary and Confidential to DMTI Spatial
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Data Dictionary (cont’d)

Building Footprints (bfr)

—— N ¥
\\3';_,

N

|

Layer Location
\Topo\AREADbfr

Layer Structure

Field Name Type Size | Description

CODE Decimal 4,0 Feature Code

FEATURE Character | 76 Feature Type

CATEGORY Character | 40 Feature Category

Layer Content
Code |Feature Code |Feature

106 ARENA 128 FISH HATCHERY

107 ARMOURY 129 FISH PROCESSING PLANT
108 AUTOMOBILE PLANT 130 GRAIN ELEVATOR

109 BARN/MACHINERY SHED 131 HALL

111 CEMENT PLANT 132 HIGHWAY SERVICE CENTRE
112 CHEMICAL PLANT 133 HOSPITAL

113 CHURCH 134 HOSTEL

114 CITY HALL 135 HOTEL

115 COAST GUARD STATION 136 KILN (TOBACCO)

116 COLLEGE 137 LUMBER MILL

117 COMMUNITY CENTRE 139 MEDICAL CENTRE

118 CONVENT 140 MONASTERY

119 CORRECTIONAL INSTITUTE 141 MOTEL

120 COURTHOUSE 142 MUNICIPAL HALL

120 COURT HOUSE 143 MUSEUM

121 CUSTOMS POST 144 NON-CHRISTIAN PLACE OF WORSHIP
122 DOME 145 OBSERVATORY

123 ELECTRIC POWER STATION 146 OIL/GAS FACILITIES BUILDING
124 FACTORY 146 GAS AND OIL FACILITIES
125 FILTRATION PLANT 147 OTHER

126 FIRE STATION 149 PARLIAMENT BUILDING

127 FIRE/POLICE STATION 150 PENITENTIARY
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Data Dictionary (cont’d)

Page 47

Code |Feature

151 PETROLEUM REFINERY
152 PLANT

153 POLICE STATION

154 PULP/PAPER MILL

155 RAILWAY STATION

156 REFORMATORY

157 SANATORIUM

158 SATELLITE-TRACKING STATION
159 SAWMILL

160 SCHOOL

161 SEMINARY

162 SENIOR CITIZENS HOME
163 SEWAGE TREATMENT PLANT
164 SHIPYARD

165 SHOPPING CENTRE

166 SPORTSPLEX

167 STEEL MILL

168 TRADING POST

169 UNIVERSITY

170 WARDEN/RANGER STATION
171 WATER TREATMENT PLANT
172 WEIGH SCALE (HIGHWAY)
172 WEIGHT SCALE

174 GREENHOUSE

175 PENAL BUILDING

176 LODGING FACILITIES

177 INDUSTRIAL BUILDING

178 RELIGIOUS BUILDING

179 EDUCATIONAL BUILDING
585 FORT: GENERIC/UNKNOWN
585 FORT

618 GREENHOUSE

1220 |STADIUM
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Data Dictionary (cont’d)

Building Points (bpp)

*

Layer Location
\Topo\AREAbpp

Layer Structure

Field Name Type Size | Description

CODE Decimal 4,0 Feature Code

FEATURE Character | 76 Feature Type

CATEGORY Character | 40 Feature Category

Layer Content
Code |Feature Code [Feature
109 |BARN/MACHINERY SHED 144  INON-CHRISTIAN PLACE OF WORSHIP
110 |CABIN 146 |OIL/GAS FACILITIES BUILDING
113 |CHURCH 148 |OUTBUILDING
114 |CITY HALL 151 |PETROLEUM REFINERY
115 |COAST GUARD STATION 155 |RAILWAY STATION
118 |CONVENT 159 |SAWMILL
122 |DOME 163 |SEWAGE TREATMENT PLANT
123 |[ELECTRIC POWER STATION 164 |SHIPYARD
125 |FILTRATION PLANT 167 |STEEL MILL
126 |FIRE STATION 170 |WARDEN/RANGER STATION
127 |FIRE/POLICE STATION 171 |WATER TREATMENT PLANT
128 |FISH HATCHERY 174 |GREENHOUSE
129 |FISH PROCESSING PLANT 178 |RELIGIOUS BUILDING
130 |GRAIN ELEVATOR 250 |CEMETERY
136 |KILN (TOBACCO) 684 |LOOKOUT
137 |LUMBER MILL 1119 |SHRINE
140 |MONASTERY
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Hydrographic Structures (hs)

¥ "‘(\
e

1
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5 2
®
Layer Location
\Topo\ AREAhs
Layer Structure
Field Name Type Size Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type
Layer Content
Code Feature
58 BOAT RAMP
58 BOAT RAMP: GENERIC/UNKNOWN
80 BREAKWALL/BREAKWATER
80 BREAKWATER: UNKNOWN
275 CONDUIT: ABOVEGROUND, PENSTOCK
275 CONDUIT: GROUND LEVEL, PENSTOCK
276 CONDUIT: UNDERGROUND, PENSTOCK
277 CONDUIT: ABOVEGROUND, OTHER
277 CONDUIT: GROUND LEVEL, OTHER
278 CONDUIT: UNDERGROUND, OTHER
289 CONDUIT BRIDGE: GENERIC/UNKNOWN
359 DAM
360 DAM: OTHER
361 DAM: SLUICE GATE
405 DRYDOCK
429 DYKE/LEVEE
429 DYKE/LEVEE: UNKNOWN
475 EXPOSED SHIPWRECK
486 FALLS
519 FISH LADDER
519 FISH LADDER: GENERIC/UNKNOWN
530 FISH POUND
530 FISH POUND: GENERIC/UNKNOWN
541 FLOODED AREA
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Code Feature

651 IRRIGATION CANAL/DITCH

662 KELP: GENERIC/UNKNOWN

673 LOCK GATE: GENERIC/UNKNOWN

673 LOCK GATE

743 NAVIGABLE CANAL: ABANDONED

744 NAVIGABLE CANAL: OPERATIONAL

755 NAVIGATION BEACON

766 NAVIGATION LIGHT

766 NAVIGATIONAL AID: NAVIGATION LIGHT

767 NAVIGATIONAL AID: NAVIGATION BEACON

777 OBSTACLE IN WATER

847 PERMANENT SNOW AND ICE: OTHER

909 POND PARTITION: GENERIC/UNKNOWN

910 POND PARTITION: FISH POUND

911 POND PARTITION: RESERVOIR

912 POND PARTITION: WASTE

967 RAPIDS

979 RESERVOIR: OPEN, DRINKING WATER RESERVOIR
980 RESERVOIR: UNDERGROUND, DRINKING WATER RESERVOIR
981 RESERVOIR: OPEN,DUGOUT

982 RESERVOIR: OPEN,FILTRATION POND

1033 ROCK IN WATER

1044 ROCKY LEDGE/REEF

1044 ROCKY LEDGE/REEF: GENERIC/UNKNOWN

1108 SEAWALL

1108 SEAWALL: GENERIC/UNKNOWN

1163 SLIP

1174 SLUICE GATE

1209 SPRING

1209 SPRING: GENERIC/UNKNOWN

1453 WATER BODY: IRRIGATION CANAL

1503 WHARF

1503 WHARF: UNKNOWN

1514 WIND-OPERATED DEVICE: GENERIC/UNKNOWN
1666 LIQUIDS DEPOT/DUMPS: LIQUID WASTE, SEWAGE POND
1667 LIQUIDS DEPOT/DUMP: LIQUID WASTE, SETTLING POND
1668 LIQUIDS DEPOT/DUMP: LIQUID WASTE, UNKNOWN
1669 LIQUIDS DEPOT/DUMP: WATER, OTHER

1670 LIQUIDS DEPOT/DUMP: WATER, FILTRATION POND
1671 LIQUID DEPOT/DUMP: WATER, DRINKING WATER
1681 HAZARD TO NAVIGATION: ROCK IN WATER

1682 HAZARD TO NAVIGATION: EXPOSED SHIPWRECK
1683 HAZARD TO NAVIGATION: OBSTACLE IN WATER
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Data Dictionary (cont’d)

Code Feature

1701 WATER DISTURBANCE: FALLS

1702 WATER DISTURBANCE: RAPID

1710 UNDERGROUND RESERVOIR: GENERIC/UNKNOWN
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Hydrography (hy)

Layer Location

\Topo\AREAhy

Layer Structure

Field Name Type Size Description
CODE Decimal 4,0 Feature Code
FEATURE Character 76 Feature Type

Layer Content

Code Feature

371 DISAPPEARING STREAM: OTHER

372 DISAPPEARING STREAM: SINKHOLE

1450 WATERBODY: INTERMITTENT/SLOUGH

1451 WATERBODY: IN STRING BOG

1452 WATERBODY: OTHER

1454 WATERBODY: FLOODED AREA

1463 |WATERCOURSE: UNKNOWN
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Industrial and Resource (ir)

Layer Location
\Topo\AREAIr

Layer Structure

Field Name Type Size | Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type
Layer Content

Code |Feature

34 AUTO WRECKER: GENERIC/UNKNOWN

34 AUTO WRECKER

347 CUT LINE: FIREBREAK

348 CUT LINE: OTHER

417 DUMP: ABANDONED

418 DUMP: OTHER

695 LUMBER YARD

695 LUMBER YARD: GENERIC/UNKNOWN

707 MINE: ABANDONED,N/A

708 MINE: OPERATIONAL,OPEN-PIT

709 MINE: OPERATIONAL,OTHER

788 OIL/GAS FACILITIES

788 GAS AND OIL FACILITIES: GENERIC/UNKNOWN

793 OIL OR GAS FIELD: GENERIC/UNKNOWN

898 PIT

923 QUARRY

1231 STOCKPILE

1242 STOCKYARD

1242 STOCKYARD: GENERIC/UNKNOWN

1435 |WASTE: OTHER, LIQUID

1436  |WASTE: SETTLING POND,LIQUID

1437 |WASTE: SEWAGE DISPOSAL POND,LIQUID

1438 |WASTE: OTHER,SOLID
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Code |Feature

1656 SOLIDS DEPOT/DUMP: DOMESTIC, WASTE, ABANDONED

1657 SOLIDS DEPOT/DUMP: DOMESTIC, WASTE, OPERATIONAL

1658 SOLIDS DEPOT/DUMP: INDUSTRIAL, WASTE, UNKNOWN

1659 SOLIDS DEPOT/DUMP: INDUSTRIAL, STOCKPILE, UNKNOWN

1690 MINING AREA: UNKNOWN, UNKNOWN, UNKNOWN

1691 MINING AREA: PIT, OPEN PIT, OPERATIONAL

1692 MINING AREA: QUARRY, OPEN PIT, OPERATIONAL

1693 MINING AREA: MINE, OPEN, PIT, OPERATIONAL

1694 MINING AREA: MINE, UNKNOWN, ABANDONED

1697 MINING AREA: MINE, UNDERGROUND, OPERATIONAL
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Land Feature Labels (llp)
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Layer Location
\Topo\AREAlIIp

Layer Structure

Field Name Type Size | Description
NAME Character | 100 Feature Name
CODE Decimal |4,0 Feature Code
FEATURE Character | 76 Feature Type
Layer Content

Code Feature

1851 TOPONYM: PLACE

1854 TOPONYM: RELIEF

1855 TOPONYM: TRANSPORT
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Land Use (lur)
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Layer Location

\Topo\AREAIur
Layer Structure
Field Name Type Size | Description
CATEGORY Character | 40 Category of Landuse

Field Content

Landuse Categories: Commercial; Government and Institutional; Open Area; Parks and Recreational;
Residential; Resource and Industrial; Waterbody.
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Other Transportation (ot)

o
Layer Location
\Topo\AREAGot
Layer Structure
Field Name Type Size | Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type
NAME Character | 100 Feature Name
Layer Content
Code |Feature
10 AERIAL CABLEWAY: GENERIC/UNKNOWN
11 AERIAL CABLEWAY: OTHER
12 AERIAL CABLEWAY: SKI LIFT
45 BARRIER/GATE: GENERIC/UNKNOWN
46 BARRIER/GATE: OTHER
47 BARRIER/GATE: TOLLGATE

440 EMBANKMENT: GENERIC/UNKNOWN

441 EMBANKMENT: OTHER

442 EMBANKMENT: CAUSEWAY

552 FOOTBRIDGE: GENERIC/UNKNOWN

563 FORD: GENERIC/UNKNOWN

1066 RUNWAY: GENERIC/UNKNOWN

1067 RUNWAY: AIRFIELD, UNKNOWN, UNKNOWN

1068 RUNWAY: AIRFIELD, OPERATIONAL, HARD SURFACE

1069 RUNWAY: AIRFIELD, OPERATIONAL, LOOSE SURFACE

1070 RUNWAY: AIRPORT, OPERATIONAL, HARD SURFACE

1071 RUNWAY: UNKNOWN, ABANDONED, UNKNOWN

1072 RUNWAY: AIRPORT, OPERATIONAL, LOOSE SURFACE

1185 SNOWSHED: GENERIC/UNKNOWN

1376 TUNNEL: GENERIC/UNKNOWN

1387 TURNTABLE: GENERIC/UNKNOWN

1720 HAZARD TO AIR NAVIGATION: GENERIC/UNKNOWN
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Data Dictionary (cont’d)

1721 HAZARD TO AIR NAVIGATION: PARABOLIC ANTENNA

1722 HAZARD TO AIR NAVIGATION: CHIMNEY

1723 HAZARD TO AIR NAVIGATION: TANK

1724 HAZARD TO AIR NAVIGATION: CROSS

1725 HAZARD TO AIR NAVIGATION: WIND-OPERATED DEVICE

1726 HAZARD TO AIR NAVIGATION: CRANE

1727 HAZARD TO AIR NAVIGATION: WATER DISTURBANCE

1728 HAZARD TO AIR NAVIGATION: BRIDGE

1729 HAZARD TO AIR NAVIGATION: NAVIGATIONAL AID

1730 HAZARD TO AIR NAVIGATION: AERIAL CABLEWAY

1731 HAZARD TO AIR NAVIGATION: TOWER

The OT layer also includes the ‘PATH’. The PATH is downtown Toronto's underground walkway and links
various office towers, parking garages, subway stations, department stores, hotels, tourist attractions, and
the Union Station railway terminal.
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Data Dictionary (cont’d)

Physiography (ph)

Layer Location
\Topo\AREAph

Layer Structure

Field Name Type Size | Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type

Layer Content

Code Feature

239 CAVE ENTRANCE

239 CAVE ENTRANCE: GENERIC/UNKNOWN
394 DRY RIVER BED

394 DRY RIVER BED: GENERIC/UNKNOWN
451 ESKER

451 ESKER: GENERIC/UNKNOWN

574 FORESHORE FLATS

731 MORAINE: GENERIC/UNKNOWN

1083 SAND: OTHER

1084 SAND: UNDERWATER
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Data Dictionary (cont’d)

Parks & Recreation Lines (prl)

%
%
Layer Location
\Topo\AREAprl
Layer Structure
Field Name Type Size | Description
CODE Decimal 4,0 Park or Recreational Feature Code
FEATURE Character | 76 Park or Recreational Feature Type
NAME Character | 68 Park or Recreational Feature Name
TYPE Character | 40 Park Designation example National, Provincial, Territorial
Parks
CLASS Character | 40 Park or Recreational Feature Classification example
wilderness, heritage or waterway
PROV Character | 2 Provincial/Territorial Abbreviation

Layer Content
CanMap Parks & Recreation lines layer represents over 2,600 recreation line features across Canada.

Features - Recreational Features

Code Feature

1198 Sports Track/Race Track: Other
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Parks & Recreation Points (prp)

A
A
A
Layer Location
\Topo\AREAprp

Layer Structure

Field Name Type Size | Description

CODE Decimal 4,0 Park or Recreational Feature Code

FEATURE Character | 76 Park or Recreational Feature Type

NAME Character | 68 Park or Recreational Feature Name

TYPE Character | 40 Park Designation example National, Provincial, Territorial
Parks

CLASS Character | 40 Park or Recreational Feature Classification example
wilderness, heritage or waterway

PROV Character | 2 Provincial/Territorial Abbreviation

Layer Content

CanMap Parks & Recreation points layer represents over 150 national, provincial and territorial parks and
over 2,300 recreation areas across Canada.

Features - Parks

Code Feature

2025 Provincial Parks

2026 Territorial Parks

Features - Recreational

Code FEATURE

206 Camp: Generic/unknown

217 Campground: Generic/unknown

250 Cemetery: Generic/unknown

607 Golf Driving Range: Generic/unknown

684 Lookout: Generic/unknown

640 Historic Site/Point of Interest

858 Picnic Site: Generic/unknown

1525 Z0o0: Generic/unknown

1672 Liquids Depot/dump: Water, Swimming Pool
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Data Dictionary (cont’d)

Parks Features - Types

Type

Provincial Park

Territorial Park

Parks Features - Classes

Class

Natural Environment

Day Use

Nature Reserve

Recreation/Heritage

Wildlife

Provincial Parks Duplicate Naming

Duplicate naming exists within the Parks & Recreation files. Duplicates exist in the following parks where
park boundaries or park names are shared by more than one province:

Park Name Prov Prov Description

Long Point Provincial Park NS ON Park name shared by more then one province

Ten Mile Lake Provincial Park NS BC Park name shared by more then one province

White Lake Provincial Park ON BC Park name shared by more then one province in
the points layer

CanMap Parks & Recreation does not represent legal park boundaries. At this time discrepancies may
exist between the CanMap Park boundaries and the CANwat boundaries.
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Parks & Recreation Regions (prr)
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Layer Location
\Topo\AREAprr
Layer Structure
Field Name Type Size | Description
CODE Decimal 4,0 Park or Recreational Feature Code
FEATURE Character | 76 Park or Recreational Feature Type
NAME Character | 68 Park or Recreational Feature Name
TYPE Character | 40 Park Designation example National, Provincial, Territorial
Parks
CLASS Character | 40 Park or Recreational Feature Classification example
wilderness, heritage or waterway
PROV Character | 2 Provincial/Territorial Abbreviation

Layer Content

CanMap Parks & Recreation regions layer represents over 1,600 national, provincial and territorial parks
and over 14,000 recreation areas across Canada.

Features - Park Features

Code Feature

2021 National Parks Polygons

2022 National Wildlife Area

2023 Migratory Bird Sanctuary

2025 Provincial Parks

2026 Territorial Parks

2027 Other Parks
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Features - Recreational Features

Code Feature

23 Amusement Park: Generic/unknown
69 Botanical Garden: Generic/unknown
217 Campground: Generic/unknown

250 Cemetery: Generic/unknown

383 Drive-in Theatre: Generic/unknown
463 Exhibition Ground: Fairground

464 Exhibition Ground: Other

596 Golf Course: Generic/unknown

607 Golf Driving Range: Generic/unknown
640 Historic Site/Point of Interest

684 Lookout: Generic/unknown

823 Parks/sports Field: Generic/unknown
858 Picnic Site: Generic/unknown

1197 Sports Track/Race Track/Drag Strip
1525 Z00: Generic/unknown

1672 Liguids Depot/dump: Water, Swimming Pool

Parks Features - Types

Type

National Park

Provincial Park

Territorial Park

Park Reserve

Ecological Reserve

Wildland Park

Wilderness Area

Wilderness Park

Protected Area

Park Area

Recreation Area

Grizzly Bear Sanctuary

Natural Area

National Wildlife Area

Migratory Bird Sancurary
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Parks Features - Classes

Class

Wilderness

Natural Environment

Heritage

Day Use

Camping

Waterway

Recreation

Nature Reserve

Historical

Recreation/Heritage

Ecological

Conservation

Education

Federal Parks Duplicate Naming

Duplicate naming exists within the Parks & Recreation files. Duplicates exist in the following parks where
park boundaries are shared by more than one province:

Park Name Prov Prov Description

St. Clair National Wildlife Area ON SK Park boundary shared by more then one province
Tuktut Nogait National Park NU NT Park boundary shared by more then one province
Wood Buffalo National Park AB NT Park boundary shared by more then one province

Provincial Parks Duplicate Naming

Duplicate naming exists within the Parks & Recreation files. Duplicates exist in the following parks where
park boundaries or park names are shared by more than one province:

Park Name Prov Prov Description

Cypress Hills Provincial Park AB SK Park boundary shared by more then one province
Duck Mountain Provincial Park | SK MB Park name shared by more then one province
Long Lake Provincial Park NS AB Park name shared by more then one province
Long Point Provincial Park NS ON Park name shared by more then one province
Mara Provincial Park ON BC Park name shared by more then one province
Sandbanks Provincial Park ON NL Park name shared by more then one province
Silver Lake Provincial Park ON BC Park name shared by more then one province
Ten Mile Lake Provincial Park NS BC Park name shared by more then one province
White Lake Provincial Park ON BC Park name shared by more then one province
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Pipelines and Transmission (pt)
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Layer Location
\Topo\ AREApt
Layer Structure
Field Name Type Size Description
CODE Decimal 4,0 Feature Code
FEATURE Character 76 Feature Type
Layer Content
Code Feature
881 PIPELINE: NATURAL GAS, ABOVEGROUND
881 PIPELINE: NATURAL GAS ,ABOVEGROUND
882 PIPELINE: NATURAL GAS,UNDERGROUND
882 PIPELINE: NATURAL GAS, UNDERGROUND
883 PIPELINE: OIL,ABOVEGROUND
883 PIPELINE: OIL ABOVEGROUND
884 PIPELINE: OIL UNDERGROUND
884 PIPELINE: OIL,UNDERGROUND
885 PIPELINE: SEWAGE/WASTE, ABOVEGROUND
885 PIPELINE: SEWAGE/WASTE,ABOVEGROUND
886 PIPELINE: UNKNOWN,ABOVEGROUND
886 PIPELINE: UNKNOWN, ABOVEGROUND
887 PIPELINE: UNKNOWN,UNDERGROUND
887 PIPELINE: UNKNOWN, UNDERGROUND
890 PIPELINE: MULTIUSE, ABOVEGROUND
891 PIPELINE: MULTIUSE, UNDERGROUND
1318 TRANSFORMER STATION (ELECTRIC)
1318 TRANSFORMER STATION: GENERIC/UNKNOWN
1330 TRANSMISSION LINE: POWER,OTHER
1330 TRANSMISSION LINE: POWER, OTHER
1331 TRANSMISSION LINE: POWER, SUBMARINE
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Code Feature
1331 TRANSMISSION LINE: POWER,SUBMARINE
1332 TRANSMISSION LINE: TELEPHONE,OTHER
1332 TRANSMISSION LINE: TELEPHONE, OTHER
1398 VALVE: GENERIC/UNKNOWN
1398 VALVE
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Railway and Transit Lines (rll)

Layer Location

\Topo\AREAII

Layer Structure

Field Name Type Size Description

OWNER Char 68 Railway Owner/Operator

CARTO Decimal 3,0 Cartographic Rail Classification

ACCESS1 Char 50 Alternate Railway Owner/Operator

ACCESS?2 Char 50 Alternate Railway Owner/Operator

ACCESS3 Char 50 Alternate Railway Owner/Operator

TRS RTE Char 68 Transit Route

RTE TYPE Char 3 Route Type

PROV Char 2 Province

US_RAILCO Char 15 American owner/operator of connecting US
railway line

US_STP Char 50 American railway station of entry on
connecting US railway line

US_STATE Char 2 American State the connecting US railway
line enters

CR Decimal 1,0 Transit: Commuter Rail Flag

LRT Decimal 1,0 Transit: Light Rail Flag

RT Decimal 1,0 Transit: Rapid Transit Flag

CODE Decimal 4,0 Classification Code

FEATURE Char 76 Railway Feature Type

RL _ID Decimal 9,0 Railway unique identifier (Unique 1D)
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% Ralil Transit lines have been integrated with the Railway lines. The TRS_TYPE and RTE_TYPE
fields have been added to the Railway lines in order to accomadate the transit data. Three flag
fields CR, LRT and RT have been included so that Rail Transit lines can be queried out to create
a separate transit layer. In cases where a transit line has shared access with a railway line, the
OWNER field will contain the railway data and the transit data will be contained in one of the
ACCESS fields.

« The MAIN, SIDETRACK and ABANDONED fields have been removed and replaced by a new

CARTO field that includes rail classifications for each of those categories and a transit carto. See
Appendix A : Cartographic Road and Rail Classifications for carto descriptions.

Layer Content

CODE FEATURE

91 BRIDGE

935 RAILWAY: ABANDONED

961 RAILWAY: SPECIAL, OTHER, OPERATIONAL, SINGLE
962 RAILWAY: OPERATIONAL

963 RAILWAY: OPERATIONAL, SIDETRACK

1376 TUNNEL

Transit Definitions

Commuter rail (CR) is a transit railway within urbanized areas, or between urbanized areas
and outlying suburbs and regions within commuting distance. These transit lines are often
shared with Railway lines.

Rapid Transit (RT) (metro, subway) is a high speed transit railway at ground level or below
within urbanized areas.

Light rail (LRT) (streetcar , tramway , automated guideway transit ) is a transit railway that
operates on a loop within the central business district of a city or connecting the business
district to its suburbs.
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Data Dictionary (cont’d)

Vegetation (ver)

Layer Location
\Topo\AREAver

Layer Structure

Field Name Type Size | Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type

Layer Content

Code |Feature

834 PEAT CUTTING

834 PEAT CUTTING: GENERIC/UNKNOWN
1343 |TREE NURSERY

1410 |VEGETATION: ORCHARD

1411 |VEGETATION: VINEYARD/HOPFIELD
1412 |VEGETATION: WOODED AREA

1413 |VEGETATION: TREE NURSERY
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Wetlands (wer)

9
L
Layer Location
\Topo\AREAwer
Layer Structure
Field Name Type Size | Description
CODE Decimal 4,0 Feature Code
FEATURE Character | 76 Feature Type

Layer Content

Code |Feature

1253 |STRING BOG

1253 [STRING BOG: GENERIC/UNKNOWN

1492 |WETLAND

1492 |WETLAND: GENERIC/UNKNOWN
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Water Feature Labels (wlp)
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Layer Location
\Topo\AREAwIp

Layer Structure

Field Name Type Size | Description
NAME Character | 100 | Feature Name
CODE Decimal 4,0 | Feature Code
FEATURE Character | 76 Feature Type

Layer Content

Code Feature

1852 TOPONYM: HYDROGRAPHY

1853 TOPONYM: SHORELINE
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Data Dictionary (cont’d)

Relative Elevation Nodes (ren)

Layer Location
\Streets\AREAren

Layer Structure

Field Name Type Size | Description

NODE _ID Decimal 8,0 Unique Identifier of node

REL E Decimal 2,0 Relative Elevation Value of node

LONGITUDE Decimal 11,6 | Longitude location of node

LATITUDE Decimal 11,6 | Latitude location of node

INTRSCTION Decimal 1,0 Flag indicating whether node is an intersection of two or more
segments or a dead end. (1 = Intersection, 0 = Dead End)

Layer Content

Relative elevation differentiates coincident nodes of varying elevation and outlines relationships between
street segments on different planes via node-and-segment connectivity. Relative Elevation Nodes (ren)
are a work-around for inherent limitations when navigating through three-dimensional street networks
represented on the two-dimensional plane (i.e. computer screen).

Ren help to establish routing options and are particularly useful where complex overpass/underpass
structures exist because they indicate street segments as being on different road-levels; where on the
computer screen all streets appear to be connected. For example, one can discern the physical
relationship of an overpass to the street below and determine that a turn directly from the overpass to the
street is prohibited. The ren layer, coupled with the Turn Restrictions Table (trn), generates the most
accurate routing.

Rule: Travel is permitted between street segments connected by a common node and prohibited
between street segments not sharing a common node. A common node (where the FROMNODE value
of one segment equals the TONODE value of another) implies a node of same relative elevation and a
turning possibility. Conversely, where a common node does not exist (implying a prohibited turn) there
are two (or more) nodes stacked directly on top of each other-- each with a different relative elevation.

Each respective street segment has two ren associated with it; one at the fromnode and the other at the
tonode. Additionally, a street will connect to another street via a common node of the same relative
elevation.
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Note: REL_ELEV values are Integer, greater than or equal to zero, depicting the relative elevation or
plane associated with a particular street segment. Actual elevations and true ground relationships of
“higher- level” and “lower- level” streets are not represented by this field.
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Data Dictionary (cont’d)

Roads (rte)

Layer Location
\Streets\AREArte

Layer Structure

Field Name Type Size  |Description
STREET* Character |69 Street Title (comprised of PRETYPE, PREDIR, STREETNAME,
SUFTYPE, SUFDIR)
FROMLEFT Decimal 6,0 Address on the Left side at the From end of the street segment
TOLEFT Decimal 6,0 Address on the Left side at the To end of the street segment
FROMRIGHT Decimal 6,0 Address on the Right side at the From end of the street segment
TORIGHT Decimal 6,0 Address on the Right side at the To end of the street segment
PREDIR Character |2 Prefix Direction component of the Street Title (e.g. W 5 St)
PRETYPE Character |10 Prefix StreetType component of the Street Title (e.g. Rue Jean)
STREETNAME |Character |45 StreetName component of the Street Title (e.g. John St E)
SUFTYPE Character |10 Suffix StreetType component of the Street Title (e.g. John St E)
SUFDIR Character |2 Suffix Direction component of the Street Title (e.g. John St E)
CARTO* Decimal 3,0 Cartographic Road Classification

LEFT_MUN# Character |70 Municipality

RIGHT_MUN# Character |70 Municipality

LEFT_MAF Character |70 Municipal Amalgamation
RIGHT_MAF Character |70 Municipal Amalgamation
LEFT_FSA Character (3 Forward Sortation Area
RIGHT_FSA Character |3 Forward Sortation Area
LEFT_PRV Character |2 Province Abbreviation
RIGHT_PRV Character |2 Province Abbreviation

UNIQUEID Decimal 9,0 Unique ldentifier of Street segment
ONEWAY Decimal 1,0 One Way flag

RTE_HIRCHY*® |Decimal 3,0 Route Hierarchy classification

% For more information refer to Appendix C: Street Types and Street Directions
% For more information refer to Appendix D: Cartographic Road Classifications

% Source: Statistics Canada, Standard Geographical Classification (SGC), 2001
8 For more information refer to Appendix E: Routing Hierarchy
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Data Dictionary (cont’d)

Field Name Type Size  |Description

RSH_TRFFC Decimal 1,0 Road segment inundated with vehicular traffic during the rush
hour. 1= rush hour traffic, 0= no rush hour traffic

MEDIAN Decimal 1,0 Single-line road segment with a median separating traffic.
1= median, 0= no median

ROAD_DIR Character |2 Road segment direction: FROMNODE to TONODE (FT) or
TONODE to FROMNODE (TF)

FROMNODE Decimal 9,0 Node begins road segment

TONODE Decimal 9,0 Node ends road segment

SPDLMT_KM Decimal 3,0 Maximum speed limit for a road segment—80% are legal posted
speed limits

SPD_MI Decimal 3,0 Estimated speed limit (miles per hour)

RDLEN_MI Decimal 7,3 Length of road segment (miles)

SPD_KM Decimal 3,0 Estimated speed limit (km per hour)

RDLEN_M Decimal 10,3 |Length of road segment (meters)

TRVLTIM Decimal 8,3 Estimated travel time (minutes) based on speed limit and road
length

RDLEN_MI_E Decimal 7,3 Adjusted road length (miles) calculated using actual distance
with elevation

RDLEN_M_E Decimal 10,3 |Adjusted road length (meters) calculated using actual distance
with elevation

TRVLTIM_E Decimal 8,3 Estimated travel time (minutes) based on speed limit and actual

road length with elevation

Field Content

Estimated Speed limits are derived using the Carto value of a Road Segment and the Population Density
in the vicinity of the Road Segment. Populated areas have a population density of at least 100 persons
per square kilometer; Sparsely Populated areas have a population density of less than 100 persons per

square kilometer.

Carto | Population Density Speed Limit (km/h) Speed Limit (mph)
SPEEDKM SPEEDMILES

1 All 100 60

2 Populated 80 50

2 Sparsely Populated | 80 50

3 Populated 60 40

3 Sparsely Populated | 80 50

4 Populated 60 40

4 Sparsely Populated | 80 50

5 Populated 50 30

5 Sparsely Populated | 80 50

6+ All 10 6

All All Ramps 50 30
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Data Dictionary (cont’d)

These highway routes are flagged in the Roads Lookup Table (rds_lut):

TransCanada Hwy
Yellowhead Hwy
Alaskan Hwy
Cariboo Hwy
Crowsnest Hwy
Dempster Hwy
John Hart Hwy
Klondike Hwy
Mackenzie Hwy

Notes:

Address fields contain “zeros” for street segments without addresses

Ramps connecting flagged highway routes are not considered part of the highway route system

Ferry Ramps connect Ferry Routes to the street network

As of CanMap v8.2 the Municipality (_ MUN) fields are attributed with 2001 Census based

Municipality names. 1996 Census based Municipality names can be obtained by linking the rte

layer to the rds_lut layer via the UNIQUEID and RDS_ID fields

= ESRIlusers: as of CanMap v8.2 all geocoding indexes have been created using 2001 Census
based Municipality names

= As of v2005.1, SPDLMT_KM attribution will be updated on an ongoing basis as part of the

production cycle
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Data Dictionary (cont’d)

Routes Look Up Table (rte_lut) =

Table Location

\Streets\AREArte_lut

Table Structure

Field Name Type Size  |Description
RDS ID Decimal 9,0 Unique ldentifier of related Routes (rte) segment
ON_RAMP Decimal 1,0 1 =0n Ramp, 0 = not an On Ramp
OFF_RAMP Decimal 1,0 1 = Off Ramp, 0 = not an Off Ramp
GRAD_FC Decimal 6,3 Gradient between the From Node and the segment Centroid
GRAD_CT Decimal 6,3 Gradient between the segment Centroid and the To Node
DIST EC Decimal 10,3 Distance along t_he gradient between the From Node and
- segment Centroid
DIST CT Decimal 10,3 Distance along the gradient between the segment Centroid and
- the To Node
EXIT_NUM Character |30 Highway Exit Number
EXIT_DIR Character |2 Ramp Exit Direction
FERRY_TYPE Character |68 Ferry Route Type (i.e. Passenger, Vehicle, etc.)

Field Content

Ferry Types information included:

Ferry Types

Canadian Passenger & Freight Ferry

US Passenger & Freight Ferry

Private Passenger & Freight Ferry

Canadian Passenger & Freight Ferry/lce Road

US Passenger & Freight Passenger Ferry/lce Road

Private Passenger & Freight Ferry/lce Road

% For more information on joining the rte_lut Table to the rds Layer refer to Appendix K: Joining the rte Layer and rds_lut Table
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Data Dictionary (cont’d)

Turn Restrictions Table (trn)

Table Location
\Streets\AREAtrn

Table Structure

Field Name Type Size Description

TURN_ID Decimal 9,0 Unique Identifier of Turn Restriction

RDS ID Decimal 9,0 Unique Identifier of Road Segment traveling upon

RES RDS ID Decimal 9.0 Uniqp(_e identifier of Road Segment to which a turn is

- - prohibited

Unique ldentifier of Road Segment that would have to be

VIA_RDS_ID Decimal 9,0 traveled upon to execute the prohibited turn to Res_Rds_Id
(u-turn on a double-lined road)

TRVLDIR Character 5 Traveling Direction of Road Segment

TYPE Character 10 Type of prohibited turn (Left., Right, Straight, U-turn) when a
legislated turn restriction exists

TIME1 FROM Character 8 Start Time of Turn Restriction

TIMEL1 TO Character 8 End Time of Turn Restriction

TIME2_FROM Character 8 Start Time of Turn Restriction

TIME2 TO Character 8 End Time of Turn Restriction

DAT FROM Character 10 First Day of turn restriction

DAY TO Character 10 Last Day of turn restriction

ON RED_ SIG Decimal 1,0 1 =No Turn on Red, 0 = Turn on any Signal

AUTH_VEHIC Decimal 1,0 1 = Authorized Vehicles only, 0 = all Vehicles Excepted

BUS EXCEPT Decimal 1,0 1 = Buses Excepted, 0 = No Exceptions

LEGISLATED Decimal 1,0 1 = Legislated, 0 = Non-Legislated

PROV Character 2 Province Abbreviation

Table Content

Turn restrictions identify road segments on which it is prohibited to turn from one street segment to
another. There are two different classifications of turn restrictions; legislated and non-legislated.

Legislated Turn Restrictions are prohibited turning movements set out by municipal bylaw where sighage
is posted. One, or a combination of several restrictions may be listed. Example: No left turn from 6 a.m.
to 9 a.m., Monday through Friday.

Non-legislated Turn Restrictions are physical restrictions that restrict turning movements-- options that
would be considered valid otherwise if the physical restriction was not captured. An example of this
situation is the overpass crossing over another street. In this scenario, a turn cannot be made directly
from the overpass to the road below and vice versa.
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Data Dictionary (cont’d)

Transportation Route Restrictions (trr)

Table Location
\Streets\AREAtrr

Table Structure

Field Name Type Size Description

RDS ID Decimal 9,0 Unique ldentifier of Transportation Route Restriction
RES TRUCK Decimal 1,0 1 = Heavy Trucks prohibited, 0 = Heavy Trucks allowed
TIME_FROM Character 8 Start Time of Restriction

TIME_TO Character 8 End Time of Restriction

DAY FROM Character 10 First Day of Restriction

DAY TO Character 10 Last Day of Restriction

RESWGT_ FUL Decimal 6,0 Maximum Weight Capacity of road

PROV Character 2 Province Abbreviation

Table Content

Transportation Route Restrictions identify streets designated as heavy truck routes as defined by a
particular municipality. Current coverage includes the CMA boundaries for the 13 capital cities of each
province and territory, the capital of Canada, and cities having a combined 1996 Census population of
500 000 or greater. The exception is Iqaluit where only the CSD boundary was utilized.

The Transportation Route Restrictions file is a lookup table that can be linked back to the Roads (rte) file
via RDS_ID in trr and UNIQUEID in rte.

CMAs Included *

Prov CMA Name 1996 Population Heavy Truck Weight (kg)

AB CALGARY 821,628 5,450
AB EDMONTON 862,597 4,500
BC VANCOUVER* 1,831,665 10,000
BC VICTORIA* 304,287 22,000
MB WINNIPEG 667,209 24,300
NB FREDERICTON 78,950 10,000
NF ST. JOHN'S 174,051 3,000
NS HALIFAX 332,518 3,000
NT YELLOWKNIFE 17,275 N/A
NU IQALUIT (CSD) N/A N/A
ON HAMILTON 624,360 4,000
ON TORONTO 4,263,757 5,000
ON/QC | OTTAWA/HULL 1,010,498 4,500/ 3,000
PE CHARLOTTETOWN 57,224 N/A

% For a complete listing of all CSDs contained within the CMA boundaries refer to Appendix F: Transportation Route Restrictions
3! Exceptions: Port Coquitlam - 4,600 kg; Richmond - 5,000 kg
%2 Exception: District of Saanich — 5,500 kg
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Page 81

Prov CMA Name 1996 Population Heavy Truck Weight (kg)

QC MONTREAL 3,326,510 3,000
QC QUEBEC 671,889 3,000
SK REGINA 193,652 9,000
YT WHITEHORSE 21,808 N/A

Heavy Truck Weight is defined as the maximum weight permitted before a vehicle is deemed a heavy
truck, designated by a particular municipality. A truck with a weight of 2 500 kg in Montreal is not

considered a heavy truck and can therefore travel on all routes within the municipality. Conversely, a
truck with a weight of 3 000 kg would be considered a heavy truck in Montreal and must therefore adhere
to travel on specified truck routes. Emergency vehicles and, in most cases, school busses are not
restricted by heavy truck routes.

Some Municipalities have time and day information associated with heavy truck restrictions:

RDS _ID RES_TRUCK | TIME_FROM | TIME_TO | DAY_FROM | DAY_TO | RESWGT_FUL | PROV
1,575,467 | 1 7:00 PM 7:00 AM Monday Saturday | O MB
2,246,640 | 1 9:00 PM 7:00 AM (none) (none) 0 NS

The first record would be interpreted: “Street segment 1575467 has a heavy truck restriction between
7:00 p.m. and 7:00 a.m. from Monday to Saturday.”

The second record would be interpreted: “Street segment 2246640 has a heavy truck restriction between
9:00 p.m. and 7:00 a.m. on every day of the week.

Note: Time component fields (TIME_FROM, TIME_TO) are not populated for street segments where
heavy truck restrictions do not exist (i.e. RES_TRUCK = 0).
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Highway Exits (xit)

Layer Location

\Streets\AREAXxit

Layer Structure

Field Name Type Size | Description
EXIT_NUM Character | 30 Highway Exit Number
EXIT_DIR Character | 2 Direction of Exit ramp

Layer Content

The exit layer is comprised of points containing exit number and direction attribution. Exit sourcing is only
available for the provinces of British Columbia, New Brunswick, Nova Scotia, Ontario, Quebec and

Newfoundland.

« EXIT_NUM field contains comma-delimited records where multiple exit numbers exist. 356, 357 —

denotes exit 356 and exit 357

» STREET field from rds table contains ampersand-delimited records where multiple exit numbers
exist: “HIGHWAY 401 (EXIT 356 & 357)”

« EXIT_DIR field direction attribution is associated with the exit number only
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Data Dictionary (cont’d)

Sample Summary of Roads (rte) Segments updated with Highway Exit Number Information

STREET PRETYPE |SUFTYPE |STREET EXIT_NUM EXIT_DIR
(rte) (rte) (rte) (rte) (rte_lut) (rte_lut)

RAMP EXIT 163 163

RAMP EXIT 107 N 107 N

293 (COLLEGE HILL

RAMP EXIT 293 (COLLEGE HILL RD%) RD)

RAMP EXIT 6 (HIGHWAY 7) N 6 (HIGHWAY 7) N
HIGHWAY 8 BYPASS HWY HIGHWAY 8 BYPASS (EXIT 278* 278
POINT ACONIRD N RD POINT ACONIRD N (EXIT 18) 18
ALDER POINT RD RD ALDER POINT RD (EXIT 19 N) 19 N

ECH SORTIE 202 202

ECH SORTIE 100 S 100 S

] 21 (COTE

ECH SORTIE 21 (COTE D'ABRAHAM) D'ABRAHAM)

] 21 (AUT DES

ECH SORTIE 21 (AUT DES LAURENTIDES) N |[LAURENTIDES) N
ROUTE 185 RTE ROUTE 185 (SORTIE 499) 499
BOUL PERROT N BOUL BOUL PERROT N (SORTIE 37) 37
ROUTE 132 RTE ROUTE 132 (SORTIE 601 N) 601 N

ECH SORTIE 76 & 77 76, 77

RAMP EXIT 29 & 31 29,31

ECH SORTIE 78 & 82 & 83 78, 82, 83

HIGHWAY 401 (COLLECTORS TO COLLECTORS TO
HIGHWAY 401 HWY EXPRESS) EXPRESS
HIGHWAY 401 (EXPRESS TO EXPRESS TO

HIGHWAY 401 HWY COLLECTORS) COLLECTORS
HIGHWAY 401 HWY HIGHWAY 401 (TO COLLECTORS) TO COLLECTORS
HIGHWAY 401 HWY HIGHWAY 401 (TO EXPRESS) TO EXPRESS

RAMP TO EXPRESS TO EXPRESS

RAMP TO COLLECTORS TO COLLECTORS

A One-to-One relationship exists between the Highway Exit Numbers and the Road (rte) segments
updated with Exit Number information and only segments intersecting an exit point are updated with exit
information. (The majority of these segments are designated as RAMP or ECH (échangeur) in the Roads
(rte) SufType field)

% parentheses contain the name of the street being exited to
% parentheses contain the exit number associated with the named road
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Data Dictionary (cont'd)

Diagram A — Basic Ramp System with Naming Conventions

SUNSET DR

EXIT 311

f ExiT 188
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Diagram C — Naming conventions in Accessing and Exiting Collector and Express Lanes

(Highway 400 in the Greater Toronto Area in Ontario)

7 HIBHWAY 401 [COLLEGTORS TO EXPRESS)

HIGHWAY 4071 (EXPRESS TO COLLECTORS)

Diagram D — Exiting an Off Ramp with a choice to take Express or Collector Lanes (Scenario 1)

TO COLLECTORS

TO EXFRESS
EXNTITE
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Data Dictionary (cont’d)

Diagram E — Exiting an Off Ramp with a choice to take Express or Collector Lanes (Scenario 2)

HIGHWAY 401 [TO EXPRESS)

v

See Insert Below

HIGHWAY 401 (TO COLLECTORS)

HIGHWW AY 409

¥ HIGHWAY 401 (TO COLLECTORS)

\/ 407 (TO COLLECTORS)

Diagram F — Named Road Segment acting as an Off Ramp

HIGHWAY 4o

o DOUGALL PKY (EXIT13)

DOUGALL PKY
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Data Dictionary (cont’d)

Diagram G — Multiple Exits from one Off Ramp

VENETIAN BLYD

FRONT TN

EXT 8 [HIGHWAY TN

EXITB (HIGHWAY 7) S

WAIN 8T
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Appendix A: ESRI® File Extensions

Refer to the following table for descriptions of ESRI file extensions. All file extensions are not available
for all DMTI products.

File Extension ArcView |ArcGIS |Both File Description

*.shp X Part of standard ESRI Shapefile
*.shx X Part of standard ESRI Shapefile
*.dbf X Part of standard ESRI Shapefile
*.aih X Part of Attribute Index

*.ain X Part of Attribute Index

*.sbn X Part of Spatial Index

*.sbx X Part of Spatial Index

*.avl X Legend Properties

*.lyr X Layer Properties

*.prj X Datum and Projection Properties
*.apr X ArcView Project file

*.mxd X ArcGIS Project file
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Refer to the following table for descriptions of Maplinfo file extensions.

File Extension

File Description

*.dat Attribute Data
*.id Graphic Index
*.ind Attribute Index
*.map Graphic Data

*.tab Tab File

*.wor Workspace
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Appendix C: Street Types and Street Directions =

Street Types

Street Types used in the CanMap® suite of products correspond to the standard abbreviations used by
Canada Post. The Language column distinguishes between street types in English (E) and street types
in French (F).

Street Type |Abbreviation Language Street Type |Abbreviation Language
Abbey ABBEY E Crescent CRES E
Acres ACRES E Corners CRNRS E
Allée ALLEE F Croissant CROIS F
Alley ALLEY E Crossing CROSS E
Autoroute AUT F Court CRT E
Avenue AV F Centre CTR E
Avenue AVE E Dale DALE E
Bay BAY E Dell DELL E
Beach BEACH E Diversion DIVERS E
Bend BEND E Downs DOWNS E
Boulevard BLVD E Drive DR E
Boulevard BOUL F Echangeur  |[ECH F
By-Pass BYPASS E End END E
Byway BYWAY E Esplanade ESPL E
Centre C F Estates ESTATE E
Campus CAMPUS E Expressway |[EXPY E
Cape CAPE E Extension EXTEN E
Carr CAR F Farm FARM E
Carrefour CARREF F Field FIELD E
Cul-de-sac CDS E Forest FOREST E
Cercle CERCLE F Front FRONT E
Chemin CH F Freeway FWY E
Chase CHASE E Gate GATE E
Circle CIR E Gardens GDNS E
Circuit CIRCT E Glade GLADE E
Close CLOSE E Glen GLEN E
Common COMMON E Green GREEN E
Concession |CONC E Grounds GRNDS E
Cote COTE F Grove GROVE E
Cour COUR F Harbour HARBR E
Cours COURS F Heath HEATH E
Cove COVE E Highlands HGHLDS E

* Source: Canada Post Corporation, The Canadian Addressing Guide, October 2002
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Appendix C: Street Types and Street Directions (cont'd)
Street Type |Abbreviation Language Street Type |Abbreviation Language
Hill HILL E Private PVT E
Hollow HOLLOW E Promenade |PROM E
Heights HTS E Quai QUAI F
Highway HWY E Quay QUAY E
ile ILE F Ramp RAMP E
Impasse IMP E Rang RANG F
Inlet INLET E Road RD E
Island ISLAND E Rond-point RDPT F
Key KEY E Range RG E
Knoll KNOLL E Ridge RIDGE E
Landing LANDNG E Rise RISE E
Lane LANE E Ruelle RLE F
Line LINE E Row ROW E
Link LINK E Route RTE E
Lookout LKOUT E Rue RUE F
Limits LMTS E Run RUN E
Loop LOOP E Sentier SENT E
Mall MALL E Square SQ E
IManor IMANOR E Street ST E
IMaze IMAZE E Subdivision |SUBDIV E
IMeadow IMEADOW E Terrace TERR E
IMews IMEWS E Thicket THICK E
IMontée IMONTEE F Townline TLINE E
IMoor IMoOR E Towers TOWERS E
IMount IMOUNT E Trail TRAIL E
Mountain MTN E Turnabout TRNABT E
Orchard ORCH E Terrasse TSSE F
Parade PARADE E Vale VALE E
Parc PARC F Via VIA E
Passage PASS E View VIEW E
Path PATH E Villas VILLAS E
Pines PINES E Village VILLGE E
Park PK E Vista VISTA E
Parkway PKY E \Voie VOIE F
Pathway PTWAY E Walk WALK E
Place PL E Way WAY E
Place PLACE F Wharf WHARF E
Plateau PLAT E \Wood WOOD E
Plaza PLAZA E Wynd WYND E
Port PORT E
Point PT E
Pointe POINTE F
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Appendix C: Street Types and Street Directions (cont'd)

Street Directions

Street Directions used in the CanMap® suite of products correspond to the standard abbreviations used
by Canada Post. The Language column distinguishes between street types in English (E) and street
types in French (F).

Street Direction Abbreviation  [Language
East E E

Est E F

Nord N F
NordEst NE F
NordOuest NO F

North N E
NorthEast NE E
NorthWest NW E

Ouest O F

South S E
SouthEast SE E
SouthWest SW E

Sud S F

SudEst SE F
SudOuest SO F

West W E
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Appendix D: Cartographic Road and Rail Classificati  ons

Carto # |Carto Name Description

1 Expressway Expressways and 400 series highways, e.g. Highway 401, Don Valley
Parkway

2 Primary Highway Primary Highway, e.g. Highway 7, Highway 11

3 Secondary Highway Secondary Highways

4 Major Road Major road or Arterial road, e.g. Bayview Ave

5 Local Road Subdivision road in a city or gravel road in a rural area

6 Trail Trails

10 Main Main Railway and Transit Lines (includes segments of rail that are
shared with transit)

11 Sidetrack Sidetrack of Main Railway Route

12 Abandoned Abandoned sections of Main Railway Route

13 Transit Transit lines that are not shared with Railway lines

20 Ferry Route Approximate travel route of Ferry

21 Ferry Ramp Ferry Ramp

22 Ice Road Approximate travel route of Ice Road

23 Ice Ramp Ice Ramp

24 Ferry Route/lce Road [Approximate travel route of Ferry/lce Road

25 Ferry/lce Ramp Ferry/lce Ramp
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Appendix E: Routing Hierarchy

Routing Hierarchy consists of six routes representing Canada’s high priority road corridors. These
corridors consist of interconnecting roads and highways that link capital cities, major provincial population
centers and important border crossing points.

» Route 1 - links Canada’s national/provincial capitals to cities with populations over 50 000

» Route 2 - links cities with populations between 20 000 and 50 000 and highways that service
major border crossings

» Route 3 - links cities with populations between 10 000 and 20 000

» Route 4 - links cities with populations below 10 000

» Route 5 - consists of intercity routes currently present within 6 of the major urban centers
(Toronto, Ottawa, Montreal, Vancouver, Victoria and Calgary)

» Route 6 - identifies all other segments within the CanMap file that have not already been
identified as being a part of Routes 1 to 5.

Route 1 Cities

Name Prov CSD Name Pop 1996

Montréal QC MONTREAL 1,016,376
Calgary AB CALGARY 768,082
Toronto ON TORONTO 653,734
Winnipeg MB WINNIPEG 618,477
Edmonton AB EDMONTON 616,306
Mississauga ON MISSISSAUGA 544,382
\Vancouver BC VANCOUVER 514,008
Laval QC LAVAL 330,393
London ON LONDON 325,646
Ottawa ON OTTAWA 323,340
Hamilton ON HAMILTON 322,352
Surrey BC SURREY 304,477
Brampton ON BRAMPTON 268,251
\Windsor ON WINDSOR 197,694
Saskatoon SK SASKATOON 193,647
Regina SK REGINA 180,400
Burnaby BC BURNABY 179,209
Kitchener ON KITCHENER 178,420
Québec QC QUEBEC 167,264
Richmond BC RICHMOND 148,867
Burlington ON BURLINGTON 136,976
Oshawa ON OSHAWA 134,364
Vaughan ON VAUGHAN 132,549
St. Catharines ON ST. CATHARINES 130,926
Longueuil QC LONGUEUIL 127,977
Nepean ON NEPEAN 115,100
Sydney NS CAPE BRETON 114,733
Halifax NS HALIFAX 113,910
Thunder Bay ON THUNDER BAY 113,662
Abbotsford BC ABBOTSFORD 105,403
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Appendix E: Routing Hierarchy (cont’d)
Name Prov CSD Name Pop 1996

Gloucester ON GLOUCESTER 104,022
St. John's NF ST. JOHN'S 101,936
Coquitlam BC COQUITLAM 101,820
Cambridge ON CAMBRIDGE 101,429
Gatineau QC GATINEAU 100,702
Guelph ON GUELPH 95,821
Sudbury ON SUDBURY 92,059
Kelowna BC KELOWNA 89,442
Brantford ON BRANTFORD 84,764
Sault Ste. Marie ON SAULT STE. MARIE 80,054
Barrie ON BARRIE 79,191
\Waterloo ON WATERLOO 77,949
Niagara Falls ON NIAGARA FALLS 76,917
Sherbrooke QC SHERBROOKE 76,786
Kamloops BC KAMLOOPS 76,394
Prince George BC PRINCE GEORGE 75,150
Victoria BC VICTORIA 73,504
Beauport QC BEAUPORT 72,920
Sarnia ON SARNIA 72,738
Saint John NB SAINT JOHN 72,494
Charlesbourg QC CHARLESBOURG 70,942
Nanaimo BC NANAIMO 70,130
Peterborough ON PETERBOROUGH 69,535
Dartmouth NS DARTMOUTH 65,629
Chicoutimi QC CHICOUTIMI 63,061
Lethbridge AB LETHBRIDGE 63,053
Hull QC HULL 62,339
Chilliwack BC CHILLIWACK 60,186
Red Deer AB RED DEER 60,075
Moncton NB MONCTON 59,313
Jonquiére QC JONQUIERE 56,503
Kingston ON KINGSTON 55,947
North Bay ON NORTH BAY 54,332
Stoney Creek ON STONEY CREEK 54,318
Fredericton NB FREDERICTON 46,507
Charlottetown PE CHARLOTTETOWN 32,531
\Whitehorse YT WHITEHORSE 19,157
Yellowknife NT YELLOWKNIFE 17,275
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Appendix E: Routing Hierarchy (cont’d)
Route 2 Cities
Name Prov CSD Name Pop 1996

New Westminster BC NEW WESTMINSTER 49,350
Trois-Rivieres QC TROIS-RIVIERES 48,419
Welland ON WELLAND 48,411
Kanata ON KANATA 47,909
Timmins ON TIMMINS 47,499
Cornwall ON CORNWALL 47,403
St. Albert AB ST. ALBERT 46,888
Medicine Hat AB MEDICINE HAT 46,783
Port Coquitlam BC PORT COQUITLAM 46,682
Chatham ON CHATHAM 43,409
North Vancouver BC NORTH VANCOUVER 41,475
Brandon MB BRANDON 39,175
Belleville ON BELLEVILLE 37,083
Prince Albert SK PRINCE ALBERT 34,777
Moose Jaw SK MOOSE JAW 32,973
St. Thomas ON ST. THOMAS 32,275
\Woodstock ON WOODSTOCK 32,086
Vernon BC VERNON 31,817
Grande Prairie AB GRANDE PRAIRIE 31,140
Penticton BC PENTICTON 30,987
Mission BC MISSION 30,519
Stratford ON STRATFORD 28,987
Qrillia ON ORILLIA 27,846
Mount Pearl NF MOUNT PEARL 25,519
Nanticoke ON NANTICOKE 23,485
Langley BC LANGLEY 22,523
Corner Brook NF CORNER BROOK 21,893
Brockville ON BROCKVILLE 21,752
Owen Sound ON OWEN SOUND 21,390
Port Moody BC PORT MOODY 20,847
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Appendix E: Routing Hierarchy (cont’d)
Route 3 Cities
Name Prov CSD Name Pop 1996

Miramichi NB MIRAMICHI 19,241
Port Alberni BC PORT ALBERNI 18,468
Port Colborne ON PORT COLBORNE 18,451
Cranbrook BC CRANBROOK 18,131
Thorold ON THOROLD 17,883
Courtenay BC COURTENAY 17,335
Vanier ON VANIER 17,247
\White Rock BC WHITE ROCK 17,210
Prince Rupert BC PRINCE RUPERT 16,714
Quinte West ON SIDNEY 16,172
Airdrie AB AIRDRIE 15,946
Yorkton SK YORKTON 15,154
Fort St. John BC FORT ST. JOHN 15,021
Swift Current SK SWIFT CURRENT 14,890
Summerside PE SUMMERSIDE 14,525
Thompson MB THOMPSON 14,385
Leduc AB LEDUC 14,305
Spruce Grove AB SPRUCE GROVE 14,271
Pembroke ON PEMBROKE 14,177
North Battleford SK NORTH BATTLEFORD 14,051
Colwood BC COLWOOD 13,848
Bathurst NB BATHURST 13,815
Camrose AB CAMROSE 13,728
Elliot Lake ON ELLIOT LAKE 13,588
Powell River BC POWELL RIVER 13,131
Portage la Prairie MB PORTAGE LA PRAIRIE 13,077
Terrace BC TERRACE 12,779
Fort Saskatchewan AB FORT SASKATCHEWAN 12,408
Lloydminster AB LLOYDMINSTER (PART) 11,317
Dawson Creek BC DAWSON CREEK 11,125
Edmundston NB EDMUNDSTON 11,033
\Wetaskiwin AB WETASKIWIN 10,959
Estevan SK ESTEVAN 10,752
Williams Lake BC WILLIAMS LAKE 10,472
Kenora ON KENORA 10,063
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Appendix E: Routing Hierarchy (cont'd)

Route 4 Cities

Name Prov CSD Name Pop 1996
Weyburn SK WEYBURN 9,723
Nelson BC NELSON 9,585
Parksville BC PARKSVILLE 9,472
Quesnel BC QUESNEL 8,468
Campbellton NB CAMPBELLTON 8,404
Revelstoke BC REVELSTOKE 8,047
Trail BC TRAIL 7,696
Lloydminster SK LLOYDMINSTER (PART) 7,636
Merritt BC MERRITT 7,631
Castlegar BC CASTLEGAR 7,027
Kimberley BC KIMBERLEY 6,738
Dryden ON DRYDEN 6,711
Drumheller AB DRUMHELLER 6,587
Flin Flon MB FLIN FLON 6,861
Brant ON BRANTFORD 6,487
Melfort SK MELFORT 5,759
Carbonear NF CARBONEAR 5,168
Fernie BC FERNIE 4,877
Melville SK MELVILLE 4,646
Duncan BC DUNCAN 4,583
Cold Lake AB GRAND CENTRE 4,176
Grand Forks BC GRAND FORKS 3,994
Armstrong BC ARMSTRONG 3,906
Rossland BC ROSSLAND 3,802
Enderby BC ENDERBY 2,754
Greenwood BC GREENWOOD 784
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PROV CSD_NAME CMA Boundary
AB AIRDRIE CALGARY
AB BEISEKER CALGARY
AB CALGARY CALGARY
AB CHESTERMERE CALGARY
AB COCHRANE CALGARY
AB CROSSFIELD CALGARY
AB IRRICANA CALGARY
AB ROCKY VIEW NO. 44 CALGARY
AB SARCEE 145 CALGARY
AB ALEXANDER 134 EDMONTON
AB BEAUMONT EDMONTON
AB BETULA BEACH EDMONTON
AB BON ACCORD EDMONTON
AB BRUDERHEIM EDMONTON
AB CALMAR EDMONTON
AB DEVON EDMONTON
AB EDMONTON EDMONTON
AB EDMONTON BEACH EDMONTON
AB ENTWISTLE EDMONTON
AB FORT SASKATCHEWAN EDMONTON
AB GIBBONS EDMONTON
AB GOLDEN DAYS EDMONTON
AB ITASKA BEACH EDMONTON
AB KAPASIWIN EDMONTON
AB LAKEVIEW EDMONTON
AB LEDUC EDMONTON
AB LEDUC COUNTY NO. 25 EDMONTON
AB LEGAL EDMONTON
AB MORINVILLE EDMONTON
AB NEW SAREPTA EDMONTON
AB PARKLAND COUNTY EDMONTON
AB POINT ALISON EDMONTON
AB REDWATER EDMONTON
AB SEBA BEACH EDMONTON
AB SPRUCE GROVE EDMONTON
AB ST. ALBERT EDMONTON
AB STONY PLAIN EDMONTON
AB STONY PLAIN 135 EDMONTON
AB STRATHCONA COUNTY EDMONTON
AB STURGEON NO. 90 EDMONTON
AB SUNDANCE BEACH EDMONTON
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Appendix F: Transportation Route Restrictions

PROV CSD_NAME CMA Boundary
AB THORSBY EDMONTON
AB WABAMUN EDMONTON
AB WABAMUN 133A EDMONTON
AB WARBURG EDMONTON
BC ANMORE VANCOUVER
BC BARNSTON ISLAND 3 VANCOUVER
BC BELCARRA VANCOUVER
BC BURNABY VANCOUVER
BC BURRARD INLET 3 VANCOUVER
BC CAPILANO 5 VANCOUVER
BC COQUITLAM VANCOUVER
BC COQUITLAM 1 VANCOUVER
BC COQUITLAM 2 VANCOUVER
BC DELTA VANCOUVER
BC GREATER VANCOUVER, SUBD. A VANCOUVER
BC KATZIE 1 VANCOUVER
BC KATZIE 2 VANCOUVER
BC LANGLEY VANCOUVER
BC LANGLEY VANCOUVER
BC LANGLEY 5 VANCOUVER
BC LIONS BAY VANCOUVER
BC MAPLE RIDGE VANCOUVER
BC MATSQUI 4 VANCOUVER
BC MCMILLAN ISLAND 6 VANCOUVER
BC MISSION 1 VANCOUVER
BC MUSQUEAM 2 VANCOUVER
BC MUSQUEAM 4 VANCOUVER
BC NEW WESTMINSTER VANCOUVER
BC NORTH VANCOUVER VANCOUVER
BC NORTH VANCOUVER VANCOUVER
BC PITT MEADOWS VANCOUVER
BC PORT COQUITLAM VANCOUVER
BC PORT MOODY VANCOUVER
BC RICHMOND VANCOUVER
BC SEMIAHMOO VANCOUVER
BC SEYMOUR CREEK 2 VANCOUVER
BC SURREY VANCOUVER
BC TSAWWASSEN VANCOUVER
BC UNIVERSITY ENDOWMENT AREA VANCOUVER
BC VANCOUVER VANCOUVER
BC WEST VANCOUVER VANCOUVER
BC WHITE ROCK VANCOUVER
BC WHONNOCK 1 VANCOUVER
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
BC BECHER BAY 1 VICTORIA
BC CAPITAL, SUBD. B VICTORIA
BC CAPITAL, SUBD. C VICTORIA
BC CENTRAL SAANICH VICTORIA
BC COLE BAY 3 VICTORIA
BC COLWOOD VICTORIA
BC EAST SAANICH 2 VICTORIA
BC ESQUIMALT VICTORIA
BC ESQUIMALT VICTORIA
BC HIGHLANDS VICTORIA
BC LANGFORD VICTORIA
BC METCHOSIN VICTORIA
BC NEW SONGHEES 1A VICTORIA
BC NORTH SAANICH VICTORIA
BC OAK BAY VICTORIA
BC SAANICH VICTORIA
BC SIDNEY VICTORIA
BC SOOKE 1 VICTORIA
BC SOOKE 2 VICTORIA
BC SOUTH SAANICH 1 VICTORIA
BC UNION BAY 4 VICTORIA
BC VICTORIA VICTORIA
BC VIEW ROYAL VICTORIA
MB BROKENHEAD 4 WINNIPEG
MB EAST ST. PAUL WINNIPEG
MB HEADINGLEY WINNIPEG
MB RITCHOT WINNIPEG
MB ROSSER WINNIPEG
MB SPRINGFIELD WINNIPEG
MB ST. CLEMENTS WINNIPEG
MB ST. FRANCOIS XAVIER WINNIPEG
MB TACHE WINNIPEG
MB WEST ST. PAUL WINNIPEG
MB WINNIPEG WINNIPEG
NB BRIGHT FREDERICTON
NB DEVON 30 FREDERICTON
NB DOUGLAS FREDERICTON
NB FREDERICTON FREDERICTON
NB KINGSCLEAR FREDERICTON
NB KINGSCLEAR 6 FREDERICTON
NB LINCOLN FREDERICTON
NB MAUGERVILLE FREDERICTON
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
NB NEW MARYLAND FREDERICTON
NB NEW MARYLAND FREDERICTON
NB SAINT MARYS FREDERICTON
NB SAINT MARY'S 24 FREDERICTON
NF BAULINE ST. JOHN'S
NF BAY BULLS ST. JOHN'S
NF CONCEPTION BAY SOUTH ST. JOHN'S
NF FLATROCK ST. JOHN'S
NF LOGY BAY-MIDDLE COVE-OUTER COVE ST. JOHN'S
NF MOUNT PEARL ST. JOHN'S
NF PARADISE ST. JOHN'S
NF PETTY HARBOUR-MADDOX COVE ST. JOHN'S
NF PORTUGAL COVE-ST. PHILIP'S ST. JOHN'S
NF POUCH COVE ST. JOHN'S
NF ST. JOHN'S ST. JOHN'S
NF TORBAY ST. JOHN'S
NF WITLESS BAY ST. JOHN'S
NS BEDFORD HALIFAX
NS COLE HARBOUR 30 HALIFAX
NS DARTMOUTH HALIFAX
NS HALIFAX HALIFAX
NS HALIFAX, SUBD. A HALIFAX
NS HALIFAX, SUBD. B HALIFAX
NS HALIFAX, SUBD. C HALIFAX
NS HALIFAX, SUBD. D HALIFAX
NS HALIFAX, SUBD. E HALIFAX
NS SHUBENACADIE 13 HALIFAX
NT YELLOWKNIFE YELLOWKNIFE
NU IQALUIT IQALUIT (CSD)
ON ANCASTER HAMILTON
ON BURLINGTON HAMILTON
ON DUNDAS HAMILTON
ON FLAMBOROUGH HAMILTON
ON GLANBROOK HAMILTON
ON GRIMSBY HAMILTON
ON HAMILTON HAMILTON
ON STONEY CREEK HAMILTON
ON CAMBRIDGE OTTAWA
ON CASSELMAN OTTAWA
ON CLARENCE OTTAWA
ON CUMBERLAND OTTAWA
ON GLOUCESTER OTTAWA
ON GOULBOURN OTTAWA
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Appendix F: Transportation Route Restrictions (cont’d)
PROV CSD_NAME CMA Boundary
ON KANATA OTTAWA
ON NEPEAN OTTAWA
ON OSGOODE OTTAWA
ON OTTAWA OTTAWA
ON RIDEAU OTTAWA
ON ROCKCLIFFE PARK OTTAWA
ON ROCKLAND OTTAWA
ON RUSSELL OTTAWA
ON SOUTH GOWER OTTAWA
ON VANIER OTTAWA
ON WEST CARLETON OTTAWA
ON AJAX TORONTO
ON AURORA TORONTO
ON BRADFORD WEST GWILLIMBURY TORONTO
ON BRAMPTON TORONTO
ON CALEDON TORONTO
ON EAST GWILLIMBURY TORONTO
ON EAST YORK TORONTO
ON ETOBICOKE TORONTO
ON GEORGINA TORONTO
ON GEORGINA ISLAND 33 TORONTO
ON HALTON HILLS TORONTO
ON KING TORONTO
ON MARKHAM TORONTO
ON MILTON TORONTO
ON MISSISSAUGA TORONTO
ON MONO TORONTO
ON NEW TECUMSETH TORONTO
ON NEWMARKET TORONTO
ON NORTH YORK TORONTO
ON OAKVILLE TORONTO
ON ORANGEVILLE TORONTO
ON PICKERING TORONTO
ON RICHMOND HILL TORONTO
ON SCARBOROUGH TORONTO
ON TORONTO TORONTO
ON UXBRIDGE TORONTO
ON VAUGHAN TORONTO
ON WHITCHURCH-STOUFFVILLE TORONTO
ON YORK TORONTO
PE BRACKLEY CHARLOTTETOWN
PE CHARLOTTETOWN CHARLOTTETOWN

www.dmtispatial.com

Proprietary and Confidential to DMTI Spatial
Not to be disclosed



[0 2005 DMTI Spatial Inc.

Appendix F: Transportation Route Restrictions (cont’d)
PROV CSD_NAME CMA Boundary
PE CLYDE RIVER CHARLOTTETOWN
PE CORNWALL CHARLOTTETOWN
PE LOT 31 CHARLOTTETOWN
PE LOT 33 CHARLOTTETOWN
PE LOT 34 CHARLOTTETOWN
PE LOT 35 CHARLOTTETOWN
PE LOT 36 CHARLOTTETOWN
PE LOT 48 CHARLOTTETOWN
PE LOT 49 CHARLOTTETOWN
PE LOT 65 CHARLOTTETOWN
PE MEADOWBANK CHARLOTTETOWN
PE MILTONVALE PARK CHARLOTTETOWN
PE ROCKY POINT 3 CHARLOTTETOWN
PE SCOTCHFORT 4 CHARLOTTETOWN
PE STRATFORD CHARLOTTETOWN
PE UNION ROAD CHARLOTTETOWN
PE WARREN GROVE CHARLOTTETOWN
PE WINSLOE SOUTH CHARLOTTETOWN
QC AYLMER HULL
QC BUCKINGHAM HULL
QC CANTLEY HULL
QC CHELSEA HULL
QC GATINEAU HULL
QC HULL HULL
QC LA PECHE HULL
QC MASSON-ANGERS HULL
QC PONTIAC HULL
QC VAL-DES-MONTS HULL
QC ANJOU MONTREAL
QC BAIE-D'URFE MONTREAL
QC BEACONSFIELD MONTREAL
QC BEAUHARNOIS MONTREAL
QC BELLEFEUILLE MONTREAL
QC BELOEIL MONTREAL
QC BLAINVILLE MONTREAL
QC BOISBRIAND MONTREAL
QC BOIS-DES-FILION MONTREAL
QC BOUCHERVILLE MONTREAL
QC BROSSARD MONTREAL
QC CANDIAC MONTREAL
QC CARIGNAN MONTREAL
QC CHAMBLY MONTREAL
QC CHARLEMAGNE MONTREAL
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
QC CHATEAUGUAY MONTREAL
QC COTE-SAINT-LUC MONTREAL
QC DELSON MONTREAL
QC DEUX-MONTAGNES MONTREAL
QC DOLLARD-DES-ORMEAUX MONTREAL
QC DORVAL MONTREAL
QC GORE MONTREAL
QC GREENFIELD PARK MONTREAL
QC HAMPSTEAD MONTREAL
QC HUDSON MONTREAL
QC KAHNAWAKE 14 MONTREAL
QC KANESATAKE MONTREAL
QC KIRKLAND MONTREAL
QC LA PLAINE MONTREAL
QC LA PRAIRIE MONTREAL
QC LACHENAIE MONTREAL
QC LACHINE MONTREAL
QC LAFONTAINE MONTREAL
QC LASALLE MONTREAL
QC L’ASSOMPTION MONTREAL
QC LAVAL MONTREAL
QC LAVALTRIE MONTREAL
QC LE GARDEUR MONTREAL
QC LEMOYNE MONTREAL
QC LERY MONTREAL
QC LES CEDRES MONTREAL
QC L'ILE-BIZARD MONTREAL
QC L'ILE-CADIEUX MONTREAL
QC L’'ILE-DORVAL MONTREAL
QC L'ILE-PERROT MONTREAL
QC LONGUEUIL MONTREAL
QC LORRAINE MONTREAL
QC MAPLE GROVE MONTREAL
QC MASCOUCHE MONTREAL
QC MCMASTERVILLE MONTREAL
QC MELOCHEVILLE MONTREAL
QC MERCIER MONTREAL
QC MIRABEL MONTREAL
QC MONTREAL MONTREAL
QC MONTREAL-EST MONTREAL
QC MONTREAL-NORD MONTREAL
QC MONTREAL-OUEST MONTREAL
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
QC MONT-ROYAL MONTREAL
QC MONT-SAINT-HILAIRE MONTREAL
QC NOTRE-DAME-DE-BON-SECOURS MONTREAL
QC NOTRE-DAME-DE-L’ILE-PERROT MONTREAL
QC OKA MONTREAL
QC OKA MONTREAL
QC OTTERBURN PARK MONTREAL
QC OUTREMONT MONTREAL
QC PIERREFONDS MONTREAL
QC PINCOURT MONTREAL
QC POINTE-CALUMET MONTREAL
QC POINTE-CLAIRE MONTREAL
QC POINTE-DES-CASCADES MONTREAL
QC REPENTIGNY MONTREAL
QC RICHELIEU MONTREAL
QC ROSEMERE MONTREAL
QC ROXBORO MONTREAL
QC SAINT-AMABLE MONTREAL
QC SAINT-ANTOINE MONTREAL
QC SAINT-ANTOINE-DE-LAVALTRIE MONTREAL
QC SAINT-BASILE-LE-GRAND MONTREAL
QC SAINT-BRUNO-DE-MONTARVILLE MONTREAL
QC SAINT-COLOMBAN MONTREAL
QC SAINT-CONSTANT MONTREAL
QC SAINTE-ANNE-DE-BELLEVUE MONTREAL
QC SAINTE-ANNE-DES-PLAINES MONTREAL
QC SAINTE-CATHERINE MONTREAL
QC SAINTE-GENEVIEVE MONTREAL
QC SAINTE-JULIE MONTREAL
QC SAINTE-MARTHE-SUR-LE-LAC MONTREAL
QC SAINTE-THERESE MONTREAL
QC SAINT-EUSTACHE MONTREAL
QC SAINT-GERARD-MAJELLA MONTREAL
QC SAINT-HUBERT MONTREAL
QC SAINT-ISIDORE MONTREAL
QC SAINT-JEROME MONTREAL
QC SAINT-JOSEPH-DU-LAC MONTREAL
QC SAINT-LAMBERT MONTREAL
QC SAINT-LAURENT MONTREAL
QC SAINT-LAZARE MONTREAL
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
QC SAINT-LEONARD MONTREAL
QC SAINT-MATHIAS-SUR-RICHELIEU MONTREAL
QC SAINT-MATHIEU MONTREAL
QC SAINT-MATHIEU-DE-BELOEIL MONTREAL
QC SAINT-PHILIPPE MONTREAL
QC SAINT-PIERRE MONTREAL
QC SAINT-PLACIDE MONTREAL
QC SAINT-SULPICE MONTREAL
QC SENNEVILLE MONTREAL
QC TERRASSE-VAUDREUIL MONTREAL
QC TERREBONNE MONTREAL
QC VARENNES MONTREAL
QC VAUDREUIL-DORION MONTREAL
QC VAUDREUIL-SUR-LE-LAC MONTREAL
QC VERDUN MONTREAL
QC WESTMOUNT MONTREAL
QC  |BEAUPORT QUEBEC
QC BERNIERES-SAINT-NICOLAS QUEBEC
QC BOISCHATEL QUEBEC
QC |CAP-ROUGE QUEBEC
QC |CHARLESBOURG QUEBEC
QC CHARNY QUEBEC
QC |CHATEAU-RICHER QUEBEC
QC FOSSAMBAULT-SUR-LE-LAC QUEBEC
QC LAC-BEAUPORT QUEBEC
QC |LAC-DELAGE QUEBEC
QC LAC-SAINT-CHARLES QUEBEC
QC LAC-SAINT-JOSEPH QUEBEC
QC L’ANCIENNE-LORETTE QUEBEC
QC L’ANGE-GARDIEN QUEBEC
QC LEVIS QUEBEC
QC LORETTEVILLE QUEBEC
QC NOTRE-DAME-DES-ANGES QUEBEC
QC PINTENDRE QUEBEC
QC |QUEBEC CITY QUEBEC
QC SAINT-AUGUSTIN-DE-DESMAURES QUEBEC
QC SAINTE-BRIGITTE-DE-LAVAL QUEBEC
QC SAINTE-CATHERINE-DE-LA-JACQUES-CARTIER |QUEBEC
QC SAINTE-FAMILLE QUEBEC
QC SAINTE-FOY QUEBEC
QC SAINTE-HELENE-DE-BREAKEYVILLE QUEBEC
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Appendix F: Transportation Route Restrictions
PROV CSD_NAME CMA Boundary
QC SAINT-EMILE QUEBEC
QC SAINTE-PETRONILLE QUEBEC
QC SAINT-ETIENNE-DE-BEAUMONT QUEBEC
QC SAINT-ETIENNE-DE-LAUZON QUEBEC
QC SAINT-FRANCOIS QUEBEC
QC SAINT-GABRIEL-DE-VALCARTIER QUEBEC
QC SAINT-JEAN QUEBEC
QC SAINT-JEAN-CHRYSOSTOME QUEBEC
QC SAINT-JOSEPH-DE-LA-POINTE-DE-LEVY QUEBEC
QC SAINT-LAMBERT-DE-LAUZON QUEBEC
QC SAINT-LAURENT QUEBEC
QC SAINT-PIERRE QUEBEC
QC SAINT-REDEMPTEUR QUEBEC
QC SAINT-ROMUALD QUEBEC
QC |[SHANNON QUEBEC
QC SILLERY QUEBEC
QC STONEHAM-ET-TEWKESBURY QUEBEC
QC VAL-BELAIR QUEBEC
QC VANIER QUEBEC
QC WENDAKE QUEBEC
SK BALGONIE REGINA
SK BELLE PLAINE REGINA
SK BUENA VISTA REGINA
SK DISLEY REGINA
SK EDENWOLD REGINA
SK EDENWOLD NO. 158 REGINA
SK GRAND COULEE REGINA
SK LUMSDEN REGINA
SK LUMSDEN BEACH REGINA
SK LUMSDEN NO. 189 REGINA
SK PENSE REGINA
SK PENSE NO. 160 REGINA
SK PILOT BUTTE REGINA
SK REGINA REGINA
SK REGINA BEACH REGINA
SK SHERWOOD NO. 159 REGINA
SK WHITE CITY REGINA
YT IBEX VALLEY WHITEHORSE
YT LAKE LABERGE 1 WHITEHORSE
YT MT. LORNE WHITEHORSE
YT WHITEHORSE WHITEHORSE
YT WHITEHORSE, UNORGANIZED WHITEHORSE
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Precision Codes

Code indicating the positional accuracy or precision of the positioned or geocoded feature.

Prec_Code

Description

Centroid of 1:50 000 NTDB feature or placed via Orthorectified photo

Block-face representative point from CanMap streets — High precision

Block-face representative point from CanMap streets — Lower precision

Postal Code - Block-face representative point

Postal Code - EA Centroid / FSA Centroid

Municipal Centroid

N[OOI |W[IN]|F-

Canadian Geographical Names Database (CGNDB)*

% May have been enhanced by removing points from water bodies
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Appendix H: Canadian Urban Areas and Abbreviations

Canadian urban areas are based upon DMTI’s topographic coverage areas. The following table is a
partial list of urban areas and their abbreviations. For a complete listing of Canadian urban areas refer to
the CANtop layer located in the Canada Directory or for information regarding other areas please contact
DMTI Spatial.

Province Topographic Coverage Area Abbreviation
AB Calgary CLGRY
AB Edmonton EDMNT
BC \Vancouver VNCVR
BC Victoria VCTRA
MB \Winnipeg WINPG
NB Fredericton FRDTN
NB Saint John STJON
NL Labrador City LBDRC
NL St. John's STJHN
NS Halifax HALFX
NT Y ellowknife YLKNF
NU Igaluit IQALT
ON Greater Toronto Area GTA
ON Hamilton Niagara HAMNG
ON Ottawa OTAWA
PE Charlottetown CHLTN
QC Hull HULL
QC Montreal MNTRL
QC Quebec City QBCTY
SK Regina RGNA
YT \Whitehorse WTHRS
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Appendix I: Exceptions to Official Time in Canada  #

In some parts of Canada, observed time practice differs from official time. The following is a list of
regions in Canada and the time practices that they observe.

British Columbia
e Boundary: British Columbia, with exceptions
o Pacific Standard Time (PST): UTC - 8h
o Pacific Daylight Time (PDT): UTC - 7h
o PDT: from 2:00 PST on the first Sunday of April to 2:00 PDT on the last Sunday of
October, the period of DST must be gazetted each year.
»  British Columbia Exceptions - Municipalities using Mountain Standard and Mountain Daylight
Time:
o Parts of Central Kootenay
Parts of Columbia_Shuswap
Parts of East Kootenay including all of Cranbrook
All of Kootenay-Boundary
All of Peace River

O o0OOo0Oo

Nunavut Territory
e Boundary: Nunavut east of 85° W longitude; except Southampton Island and the “islands near
Southampton Island”.
o Eastern Daylight Time (EDT): UTC - 4h
o EDT: from 2:00 EST on the first Sunday of April to 2:00 EDT on the last Sunday of
October
e Boundary: Nunavut's Southampton Island and the “islands near Southampton Island”
o Eastern Standard Time (EST): UTC - 5h
e Boundary: Nunavut west of 85° W longitude and east of 102° W longitude; except Southampton
Island ,“the islands near Southampton Island”, and the“Kitikmeot Region”
o Central Standard Time (CST): UTC - 6h
o Central Daylight Time (CDT): UTC - 5h
o CDT: from 2:00 CST on the first Sunday of April to 2:00 CDT on the last Sunday of
October
e Boundary: Nunavut west of 102° W longitude; (and all of the “Kitikmeot Region”)
0 Mountain Standard Time (MST): UTC - 6h
0 Mountain Daylight Time (MDT): UTC - 5h
o MDT: from 2:00 MST on the first Sunday of April to 2:00 MDT on the last Sunday of
October

Ontario

» Boundary: Ontario east of 90° W longitude
o Eastern Standard Time (EST): UTC - 5h
o Eastern Daylight Time (EDT): UTC - 4h
o EDT: from 2:00 EST on the first Sunday of April to 2:00 EDT on the last Sunday of
October
« Boundary: Ontario west of 90° W longitude
o Central Standard Time (CST): UTC - 6h
o Central Daylight Time (EDT): UTC - 5h
o CDT: from 2:00 CST on the first Sunday of April to 2:00 CDT on the last Sunday of
October

% Source: National Research Council (NRC), April 2001
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Quebec

» Boundary: Quebec east of 63° W longitude
0 Atlantic Standard Time (AST): Coordinated Universal Time (“UTC") - 4h
o In effect year-round
e Boundary: Quebec west of 63° W longitude
o Eastern Standard Time (EST): UTC - 5h
o Eastern Daylight Time (EDT): UTC - 4h
o EDT: from 2:00 EST on the first Sunday of April to 2:00 EDT on the last Sunday of
October

Saskatchewan

« Boundary: the Battle River district (around Lloydminster, in 1983 the Payton time option area was
created, it uses CST year-round)
o Central Standard Time (CST): UTC - 6h
o CST: from 2:00 MST on the first Sunday of April to 2:00 CST on the last Sunday of
October
* Boundary: Saskatchewan side of Lloydminster
0 Mountain Standard Time (MST): UTC - 7h
0 Mountain Daylight Time (MDT): UTC - 6h
o MDT: from 2:00 MST on the first Sunday of April to 2:00 MDT on the last Sunday of
October

Yukon Territory
o Pacific* Standard Time (PST): UTC - 8h
o Pacific* Daylight Time (PDT): UTC - 7h
o PDT: from 2:00 PST on the first Sunday of April to 2:00 PDT on the last Sunday of

October

* Yukon regulations refer to this as “Yukon” rather than Pacific time. Federal legislation (the
Interpretation Act) still specifies Yukon time as one hour west of Pacific time. Using “Pacific”
avoids this legislative ambiguity.
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Appendix J: Unshorelined vs. Shorelined Boundaries

National Water Layer

DMTI Spatial's standard boundaries are referred to as unshorelined boundaries. Unshorelined
boundaries suggest that the boundary does not reflect physical shorelines.

Not recommended: “Unshorelined” boundaries  Recommended: “Unshorelined” boundaries with the national
with the national water (CANwat) layer beneath water (CANwat) layer on top of the boundary layer.
the boundary layer.

Shorelined boundaries are available from DMTI Spatial as a custom order. These boundaries are created
using a subset of the CANwat layer, which is used to clip the overlap between the unshorelined
boundaries.

Topographic Coverage Areas

With the purchase of CanMap Streetfiles and CanMap RouteLogistics DMTI Spatial provides a detailed
water layer (AREAhy). Detailed water is only available in topographic coverage areas only.

It is not recommended that you view any shorelined boundaries with the detailed water layer (AREAhy),
as the two layers will not align with each other.

Detailed water layer (AREAhy) and shorelined National water layer (CANwat) and shorelined
census boundaries census boundaries

Please contact DMTI Spatial if you require a detailed nationwide water product or shorelined boundaries
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To view the AREArds data linked to the AREArds_lut data the user must complete a manual join.

Maplnfo

» Open both the AREArds data file and the
AREArds_lut data file in Maplinfo.

» Select ‘Query’> ‘SQL Select...’

» Complete the following query in the Query
Menu (See Figure 1)

» Select * from AREArds, AREArds_lut where
AREArds.UNIQUEID = AREArds_Iut.RDS_ID

» ‘Verify' the SQL query and if valid, press ‘OK’.

Once the query result has been obtained you can then
view the joined tables e.g. ‘Joined_Results’ via the Info
Tool in the Map Window or through the
‘Joined_Results’ Table Browser.

To create a permanent join simply save the joined
tables as a new Maplinfo Table.

Select Colurmns:

L)

I Tables

Calurmns

fram T ables:

AREAds, AREArds_ut

Operators

where Conditior:

AREArds UNIQUEIDD =
AREArds_IutRDS_ID

Aggregates

Funictions

Group by Columns: I

Order by Columng: I

Save Template

into T able Mamed: I
|V Browse Fesults

ok |

Joined_Results

1R

Load Template

Cancel | Clear | Werify I Help |

ArcView

>

vVV V V¥V

\ %4

Figure 1: Joining MaplInfo Tables

With the project file open, click on the Window menu and select the project (AREArds.apr) to

display the project window.

With the project window now displayed select the ‘Tables’ icon. Click on the ‘Add’ button, locate
and open the AREArds_lut data table you wish to join.
With the AREArds_lut table displayed click on the field (RDS_ID) that will be used to join the
AREArds_lut table to the AREArds data table. Now return to the View with the AREArds file.

Click on the AREArds theme in the legend to make

it active.

Click on the ‘Open Theme Table’ button to display the AREArds attribute table (or choose Theme

from the Table menu).

Click on the field that will be used to join the AREArds data table (UNIQUEID).
Finally, click on the Join button (or choose Join from the Table menu)

When you scroll along the AREArds attribute table you will notice the AREArds_lut data has been joined.
Additional data tables can be joined, so that many table attributes can be shown at one time. To undo the
joins between the data tables click on the AREArds attribute table making it active and from the ‘Table’

menu select ‘Remove All Joins’.
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Table (cont’'d)

ArcGIS

» Open the appropriate project file
(AREArds.mxd).

» Select the ‘Add Data’ button to open the
corresponding attribute data file
(AREArds_lut.dbf) you wish to join.

» Select the AREArds theme, right click and
select ‘Joins and Relates’ selecting
‘Join..." from the sub-menu of choices.

» Complete the ‘Join Data’ GUI as shown
below using the UNIQUEID and RDS_ID
fields as the common field between the
tables. Once complete hit ‘OK'.

» Once the join is complete select the
AREArds theme, right click and select
‘Open Attribute Table’. Once open, you
can now scroll through the results of the
join.

» Additional data tables can be joined, so
that many table attributes can be shown at
one time. To undo the joins between the
data tables select the AREArds attribute
table, right click and select ‘Joins and
Relates’ selecting ‘Remove Join(s)’ from
the sub-menu of choices. Select the table
you wish to remove the join from the list
provided (i.e. AREArds_lut.dbf).
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Jain letz you append additional data to this layer's attribute table 2o pou can,
for example, symbolize the layer's features using thiz data.

what do pou want to join ta this laper?

IJnin attributes fram a table j

1. Chooze the field in this layer that the join will be based on:
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Figure 2: Joining Layers in ArcGIS.
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Appendix L: RouteView Pro

RouteView Pro is an extension to MaplInfo Professional providing a user with routing and catchment area

functionality.

How to use the data in RouteView Pro

1. Open the RouteView Pro extension. In Mapinfo Professional, under the File pulldown menu,
select ‘Run MapBasic Program’ and run “c:\Program Files\Dataview\RV Pro 1.2\rvpro.mbx”

2. Under the RouteView Pro pulldown menu, select ‘Configuration’, then ‘Open Road Network’.

3. The Road Network file to open is \RVP\Nad83\CanMapRL\Geography\ rvp.gph and the Road
Table is \RVP\Nad83\CanMapRL\Geography\ _rvp.tab

4. Start using RouteView Pro.

File Structure: (_rvp.tab)

Field Name Field Type Field Description
Size
ID Decimal 9,0 Unique identifier for RouteView Pro
NAME Character 69 Street Name
TYPE Character 10 Road classification
YSKA Integer - Turn restriction code used by RouteView Pro
ONE_WAY Character 1 F - if road is one-way in direction of start to end (direction of
digitization)
R - if road is one-way in direction of end to start (reverse
direction of digitization)
Left blank — if road is 2 way
Notes:

= All files found within the \RVP\Nad83\CanMapRL\ AREA\ directory are needed by RouteView
Pro. DMTI does not provide RouteView Pro software or tools—please contact software vendor.

= Toview all of CanMap® RoutelLogistics in Maplnfo Professional, please use the data within the
\MapInfo\Nad83\CanMapRL\ AREAN\ directory.
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Appendix M: ArcView 3.2 Route to Network Analyst =

DMTI Spatial is pleased to provide ArcView 3.2 users a tool that allows users to convert CanMap®
Routelogistics shape files to a Network Analyst (ArcView V3.2) routing file. The ArcView 3.2 Route to
Network Analyst (RteNA) tool was designed to convert DMTI Spatial route (rte) files and turn restrictions
table (trn) files into ArcView Network Analyst compatible routing files. The “open” script allows users to
ensure optimal use of the CanMap RoutelLogistics product within a software program or application.

Tool Location
\_samples\RteNA

How to Use the RteNA Tool

» Open the RteNA.apr
» Click the RteNA Tool button - located on the View GUI, to the left of the Help button

Eile Edt “iew Theme Graphice Mebwork afindow  Help

i [EE [P

NN ERETE AR =

Important: All of the Network Analyst generated files including the *rte_na.nws directory must exist in the
same directory before processing can begin. Any missing files will prevent routing from being possible.

File Description
AREArte.shp Routing Shape File
AREArte.shx Routing Shape File
AREArte.dbf Routing Shape File
AREArte.avl ArcView Legend File
AREAtrn.dbf Turn restriction table
AREArds_lut.dbf RDS Lookup table
AREArte lut.dbf RTE Lookup table

A converted rte file will be added to the View and the link to the turn restriction table (*trn_na.dbf) is
established. The directory should contain the following files:

File Description

AREArte_na.shp Resulting rte file compatible with Network Analyst
AREArte_na.shx Resulting rte file compatible with Network Analyst
AREArte_na.dbf Resulting rte file compatible with Network Analyst
AREArte_na.sbn Spatial Indexes

AREArte_na.sbx Spatial Indexes

AREAtrn_na.dbf Resulting trn file compatible with Network Analyst
AREArte_na.nws Directory for routing files as created by Network Analyst

At this point, users are ready to use Network Analyst for routing. (i.e. ‘Find Best Route’ function).

% This tool is currently provided for free and is not currently supported by DMTI Spatial. If you require any assistance please
contact DMTI Spatial.
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Appendix M: ArcView 3.2 Route to Network Analyst (cont'd)

Preserving or Re-Establishing the Link between the *rte_na and *trn_na files:
In order to perform routing in future sessions of Network Analyst, the project (RteNA.apr) must be saved
to maintain the link between the *rte_na and *trn_na files. If you do not wish to save the project file, an

alternative option is to re-establish the link between the two files by following the instructions given below
for the ‘SetTurnTable.ave’ script.

How to Use ‘SetTurnTable.ave’
Instructions for running the ‘SetTurnTable.ave’ script (located at: \_samples\RteNA\Scripts)
Open a new session of ArcView 3.2
« Activate the Network Analyst extension
» From the project menu: File > Extensions > Check on the Network Analyst extension > Click OK
Open a new View
» From the Project window: Double click on the View icon or single click on the View icon > Click

the New button

Add the converted *rte_na.shp to the View
*  From the View menu: Click on View > Add Theme... > Browse for the file > Click OK

Open a new script document
» From the Project window: Double Click on the Scripts icon or single click on the Scripts icon >
Click on the New button
Load the script into the new script document
» From the Script menu: Click on Script > Load Text File... > Browse to the Scripts directory select
‘SetTurnTable.ave’ > Click OK
Compile and run the script
e From the script menu: Click on Script > Compile > Click on the View to make it active > Click on
the Window Menu > Select Scriptl > Run
Select the *rte_na.shp theme from the list > Click OK
Browse to the *trn_na.dbf > Click OK
Close the Script window
Save the ArcView project to maintain the links generated within this process for future use

Important Notes to remember:

When running the RteNA.apr scripts, all files must have DMTI Spatial naming (ex: GTArte.shp). This
means the files CANNOT be renamed, as the program will not recognize the required files.

After the processing is complete the original trn.dbf and *rte.* files can be removed from the directory as
they are not used by Network Analyst.

If you start a new session and set the turntable, you must save the project to keep the link to the
turntable.
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Appendix N: ArcLogistics Route v3.0

File Descriptions

File Description

Allst.shp CanMap RouteLogistics
Oneway.shp One Way Streets
Turn.shp Turn Restrictions
Exit.shp Highway Exit Numbers
Dtl-cnty.shp Municipal boundaries
Zip.shp Forward Sortation areas
Lakes.shp Water Features
Parks.shp Park Boundaries
States.shp Provincial Boundaries

File Structure

Roads - Allst.shp

Field Name Field Type Field Size | Description

FULL_NAME Character 69 Street Name

L_F_ADD Decimal 6,0 From Left Address

L T ADD Decimal 6,0 To Left Address

R _F ADD Decimal 6,0 From Right Address

R T ADD Decimal 6,0 To Right Address

PREFIX Character 2 Prefix Direction before Street Name (e.g. W 5 St)

PRE_TYPE Character 10 Prefix Type before Street Name (e.g. Rue Jean)

NAME Character 45 Street Name (e.g. John StE)

TYPE Character 10 Street Type after Street Name (e.g. John St E)

SUFFIX Character 2 Suffix Street Direction after Street Name (e.g. John St
E)

ALIAS NAME Character 69 Alternate Street Name

FORMERNAME® | Character 69 Former Provincial Hwy Name

HWY NAME Character 69 Highway Names

HWY NUM Character 20 Highway Number(s)

CARTO Decimal 3,0 Road Classification

CITYL Character 70 City Name to the left of the road segment

CITYR Character 70 City Name to the right of the road segment

ZIPL Character 3 FSA (Forward Sortation Area) to the left of the road
segment

ZIPR Character 3 FSA (Forward Sortation Area) to the right of the road
segment

STATE ABBR Character 2 Province Abbreviation (e.g. Ontario = ON)

TRNSCDAHWY Decimal 1,0 1 = TransCanada Highway

YELOWHDHWY Decimal 1,0 1 = Yellow Head Highway

TOLL RD Decimal 1,0 1 =Toll Road

SHAPEID Decimal 9,0 Unique Identifier from ArcLogistics Route

USERID Decimal 9,0 Unique Identifier from CanMap™ Streetfiles

CFCC Character 3 ArcLogistics Route code for classifying street

DISP_CODE Decimal 2,0 ArcLogistics Route code for displaying street

segments

% Applicable only in Ontario
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ONEWAY Decimal 1,0 1 = Oneway segment

ON_RAMP Decimal 1,0 1 =0n Ramp

OFF RAMP Decimal 1,0 1 = Off Ramp

EXIT_NUM Character 30 Highway exit number

EXIT DIR Character 2 Direction of exit ramp

ROAD_DIR Character 2 Segment direction is either from the Fnode to the
Tnode (FT) or from the Tnode to the Fnode (TF)

FNODE Decimal 9,0 Node begins line segment

TNODE Decimal 9,0 Node ends line segment

F ZLEV Decimal 2 Elevation of Fnode

T ZLEV Decimal 2 Elevation of Tnode

SPEEDMILES® Decimal 3,0 Estimated speed limit (miles per hour)

RDLENMILES Decimal 8,3 Length of segment in miles

SPEEDKM* Decimal 3,0 Estimated speed limit (kilometers per hour). See note
below.

METERS Decimal 8,3 Length of segment in meters

FT_MINUTES Decimal 6,3 Estimated travel time in minutes based on speed limit
and road length

TF_MINUTES Decimal 6,3 Estimated travel time in minutes based on speed limit
and road length

FERRY_TYPE Character 68 Type of ferry route (ex. Passenger, vehicle, etc.)

One-way Streets (oneway.shp)

Field Name Field Type | Field Size Description

SHAPEID Decimal 9,0 Unique Identifier from ArcLogistics Route

USERID Decimal 9,0 Unique ldentifier from CanMap® Streetfiles

ONEWAY Decimal 1,0 1 = Oneway segment

Turn Restrictions (turn.shp) *

Field Name Field Type | Field Size Description

FSHAPEID Decimal 9,0 Eror? segment unique Identifier from ArcLogistics

oute

TSHAPEID Decimal 9,0 To segment unique Identifier from ArcLogistics Route

F_USERID Decimal 9,0 From segment unique Identifier from CanMap
RouteLogistics

T_USERID Decimal 9,0 To segment unique Identifier from CanMap
RouteLogistics

Highway Exit Numbers P (exit.shp)

Field Name Field Type | Field Size Description

EXIT _NUM Character 30 Highway exit number

EXIT DIR Character | 2 Direction of exit ramp

Municipality Boundaries (dtl-cnty.shp)

Field Name Field Type | Field Size Description
NAME Character 70 Municipality Name
TYPE Character 3 Type of Community

0 For more information refer to Roads (rte)

“! For more information refer to Turn Restrictions (trn)
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Forward Sortation Areas (zip.shp)

Field Name Field Type [ Field Size Description

ZIP Character 3 FSA (first 3 digits of postal code)
Parks (parks.shp)

Field Name Field Type | Field Size Description

TYPE Character 40 Type of recreational park

Provincial Water (lakes.shp)

Field Name Field Type | Field Size Description

NAME Character 40 Lake/River Name

Provincial Outline (state.shp)

Field Name Field Type [ Field Size Description
NAME Character 68 Province Name
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Appendix N: ArcLogistics Route v3.0  (cont'd)

Installation of CanMap RouteLogistics for ArcLogist ics Route

1. Create a new directory for the data on one of your local drives.

2. Copy all the directories and files under the \AlrNad83\CanmapRL\Geography \Alr_data
directory on the CD to this new directory.

3. Delete the files in the ..\ArcLogistics Route\Background directory from your computer, then

copy the files in the \AlINad83\CanmapRL\Geography \Background directory into

.\ArcLogistics Route\Background.

Under the Start Menu select ESRI\ArcLogistics Route — Administer Streets.

Click the Street Data option and then New. A Set Up Streets Dialog will be displayed.

Enter a Name for the New Street Dataset (e.g. Ontario).

Choose the unit for ArcLogistics Route to display distances in the MapView window.

Choose the unit used by the input data found in this folder

\AInNad83\CanmapRL\Geography \Alr_data.

9. Browse to the folder location of the map data files.

10. Check the box to Rebuild Routing and Geocoding Indices.

11. Click OK. A default service area file will be created for the street dataset.

12. Your data is now ready for ArcLogistics Route. Close the Administer Streets window.

13. Open ArcLogistics Route.

14. Under File, select Open Service Area. Open the Service Area that you created under the
Administer Streets window. Start using ArcLogistics Route.

©No O A

Changing speeds in CanMap RouteLogistics for ArcLog istics Route

1. Close all windows associated with ArcLogistics Route
2. Inthe alr_data, make a backup copy of the allst.dbf file. For example, copy the allst.dbf to
allst_bk.dbf
3. Import allst.dbf into Microsoft Access or open it in Microsoft Excel
4. Re-populate the SPEEDMILES field and the SPEEDKM field to your desired speeds
5. Re-calculate the FT_MINUTES and TF_MINUTES (they both should have the same time) using
the following formula:
1. FT_MINUTES = Meters * .001 / SPEEDKM * 60
2. TF_MINUTES = Meters * .001 / SPEEDKM * 60
6. Save the changes to allst.dbf as a dbase 3 file
7. Re-open the Administrator window for ArcLogistics route and rebuild the routing and geocoding
indices.
8. Re-open ArcLogistics Route and rebuild the routes
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Appendix N: ArcLogistics Route v3.0  (cont'd)

Loading a newer version of CanMap RouteLogistics in to ArcLogistics Route

If you have received a previous version of CanMap RouteLogistics in ArcLogistics Route format and wish
to refresh the data with the new version contained on this CD, please follow the subsequent steps:

Note: This methodology is necessary if you have created Locations, Orders and Vehicles based on a
previous version of CanMap RouteLogistics and you wish to preserve this information and use it in
conjunction with the newer version of CanMap RoutelLogistics. For Example, changing from CanMap
RoutelLogistics V4.2 to V6.1

1. Make a backup copy of your current directory containing CanMap RouteLogistics in ALR format
and all Access databases (i.e. ALR.mdb, ALR1.mdb) containing your Orders, Locations, Vehicles,
etc.

2. Copy the new CanMap RouteLogistics data in ALR format directly onto the existing older version
of CanMapRoutelLogistics in ALR format.

Example:
Current ALR data location:

C:\_MY _FILES\ALRDATA\Gta\Alr_data\
C:\_MY _FILES\ALRDATA\Gta\Background\

New data extracted from CD into “_MY_FILES” directory:
C:\_MY _FILES\ALR\NAD83\CANMAPRL\GTA\AIr_data\
C:\_MY _FILES\ALR\NAD83\CANMAPRL\GTA\Background\

a. Note: Itis important that the directory names and path remain the same as when the
streets were last Indexed in the Administer Streets utility
b. Note: Your Access databases (ALR.mdb, ALR1.mdb etc) will not be overwritten, but all
other layers containing CanMap RouteLogistics will be overwritten.
3. Rebuild both Geocoding and Routing indices from the Administer streets prompt
4. Open ArcLogistics Route (specify the service area you are refreshing if you have more than one)
a. Note: The colour of the Routing sub folders should be a slightly paler yellow than the
main “Routing Folder”. This indicates that ALR has detected your new CanMap
Routelogistics data
5. Reroute by using the “Build Route” button to refresh and create new routes based on the existing
Locations, Vehicles and Orders.
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Appendix O: SDC Format

The SDC v2.0 format files are available in the following packaged areas: Canada, Ontario, Quebec,
British Columbia, Atlantic Region (PEI, NB, NS, NFL/Lab), Prairies/Central (AB, SK, MB, YK, NWT, NU),
and GTA.

Software Requirements

CanMap RouteLogistics is packaged using SDC version 2.0 standards. As such, these files can only be
used with versions of ESRI ArcGIS 9.x and above, including ArcIMS 9.x.

Because CanMap SDC files are standardized to comply with ESRI software standards, it is necessary to
install ESRI Street Map Rules (SMrules.exe) in order ensure geocoding functionality.

File
\CanMapRL\SMrules.exe

For more information on geocoding rules please refer to the following link:

http://support.esri.com/index.cfm?fa=knowl edgebase.qisDictionary.search& searchT erm=geocod
iNng%20rul €%20base

SDC Naming Conventions

CanMap RouteLogistics SDC files are organized into the following directory structure and use the
following directory and file naming conventions:

Example: \CanMapRL\AREA\Streets\ONrte

Product Geographic Area | General Content Geographic Area File Content
Directory Directory Directory Abbreviation Abbreviation
CanMapRL | ON Streets ON rte

The geographic area directory area indicates the packaged areas, for example
ATLTC= Atlantic Region
PRCTL= Prairies/Central

For the layers’ attributes, please refer to the Data Dictionary of CanMap RouteLogistics User Manual.

Routing Index
Routing Index is the routing indexes which enable routing functionality in ArcGIS 9.x and ArcIMS 9.x
RouteServer.

Layer Location
\CanMapRL\AREA\Streets\AREArte_GR.rsx\
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Appendix O: SDC Format ( Cont'd)

Layer Structure ( AREArte_GR)

Field Name Type Size | Description

ADDR_PD Character | 2 Prefix Direction component of the Primary Street Title (e.g. W 5
St)

ADDR_PT Character | 20 Prefix Street Type component of the Primary Street Title (e.qg.
Rue Jean)

ADDR_SN Character | 40 Street Name component of the Primary Street Title (e.g. John
StE)

ADDR_ST Character | 20 Suffix Street Type component of the Primary Street Title (e.g.
John St E)

ADDR_SD Character | 2 Suffix Direction component of the Primary Street Title (e.g.
John St E)

ADDR1 PD Character | 2 Prefix Direction component of Alias Street Name

ADDR1 PT Character | 20 Prefix Street Type component of Alias Street Name

ADDR1 SN Character | 40 Street Name component of Alias Street Name

ADDR1 ST Character | 20 Suffix Street Type component of Alias Street Name

ADDR1 SD Character | 2 Suffix Direction component of Alias Street Name

ADDR2 PD Character | 2 Prefix Direction component of Former Provincial Hwy Name

ADDR2 PT Character | 20 Prefix Street Type component of Former Provincial Hwy Name

ADDR2 SN Character | 40 Street Name component of Former Provincial Hwy Name

ADDR2_ST Character | 20 Suffix Street Type component of Former Provincial Hwy Name

ADDR2_SD Character | 2 Suffix Direction component of Former Provincial Hwy Name

ADDR3 PD Character | 2 Prefix Direction component of Highway Numeric Name

ADDR3 PT Character | 20 Prefix Street Type component of Highway Numeric Name

ADDR3 SN Character | 40 Street Name component of Highway Numeric Name

ADDR3 ST Character | 20 Suffix Street Type component of Highway Numeric Name

ADDR3 SD Character | 2 Suffix Direction component of Highway Numeric Name

FROMLEFT Decimal 6,0 | Address on the Left side at the From end of the street segment

TOLEFT Decimal 6,0 | Address on the Left side at the To end of the street segment

FROMRIGHT Decimal 6,0 | Address on the Right side at the From end of the street
segment

TORIGHT Decimal 6,0 | Address on the Right side at the To end of the street segment

PREDIR Character | 2 Prefix Direction component of the Street Title (e.g. W 5 St)

PRETYPE Character | 10 Prefix StreetType component of the Street Title (e.g. Rue Jean)

SUFTYPE Character | 10 Suffix StreetType component of the Street Title (e.g. John St E)

SUFDIR Character | 2 Suffix Direction component of the Street Title (e.g. John St E)

CARTO* Decimal 3,0 | Cartographic Road Classification

LEFT _MUN® Character | 70 Municipality

LEFT FSA Character | 3 Forward Sortation Area

LEFT PRV Character | 2 Province Abbreviation

UNIQUEID Decimal 9,0 Unique ldentifier of Street segment

ONEWAY Decimal 1,0 | One Way flag

FROMNODE Decimal 9,0 Node begins road segment

TONODE Decimal 9,0 Node ends road segment

SPD_KM Decimal 3,0 Estimated speed limit (km per hour)

“2 For more information refer to Appendix D: Cartographic Road Classifications
3 Source: Statistics Canada, Standard Geographical Classification (SGC), 2001
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Appendix O: SDC Format ( Cont'd)

FROM_ELEV Integer Relative Elevation Value of From node

TO_ELEV Integer Relative Elevation Value of To node

ONEWAYS2 Character |2 Oneway Road segment direction: FROMNODE to TONODE
(FT) or TONODE to FROMNODE (TF)

Geocoding Index

The geocoding index enables geocoding in ArcIMS RouteServer and ArcGIS. ESRI calls upon the
geocoding index via address locators, files with the *.loc extension. CanMap RouteLogistics provides
four address locators:

File Location
\CanMapRL\AREA\sm_AREArte_gr_street_address.can.loc
\CanMapRL\AREA\sm_AREArte_gr_street_address_altname.can.loc
\CanMapRL\AREA\rs_AREArte_gr_street Reverse.can.loc
\CanMapRL\AREA\rs_AREArte_gr_street_address.can.loc

The geocoding index itself is a series of files that point towards specific fields in the SDC files.

File Location
\CanMapRL\Area\Streets\AREArte_GR.idx

For more information on geocoding please refer to the following link:
http://support.esri.com/index.cfm?fa=knowl edgebase.qgisDi ctionary.search& searchTerm=geocod

iNng%20index

Layer Structure

The Geocoding Index layer structure is the same as Routing Index layer structure, please refer to Routing
Index Layer Structure for the detailed information.

AXL files

Customizable AXL files are available for use with ESRI's ArcIMS software. These files attempt to mimic
the CanMap RouteLogistics symbology and contain all CanMap RouteLogistics layers.

File Location
\CanMapRL\Area\Areartp.ax|

In order for the *.axl files to work ‘out of the box’ the SDC files must be put into the following directory
structure:

C:\SDC\CanMapRL\AREA
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Appendix P: ISO 19115:2003 Compliant Metadata

Metadata Notification

As of May 15" 2005, DMTI Spatial data products have metadata that are 1S0 19115:2003 compliant.

This product now includes structured metadata files as provided in XML and/or HTM format. These
metadata files reside with the graphic or database files to which they are associated. It is recommended
that users review and customize the metadata as per their specific needs.

This latest addition to the CanMap® line of products is another enhancement that will benefit our users
and increase overall product satisfaction.
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